# CONTENTS

1 Categories ........................................... 3
   1.1 Category ........................................... 3
   1.2 Creating a Category .................................. 3
   1.3 Category overview .................................... 4
   1.4 Category Management Area .......................... 6

2 Conferences ........................................ 11
   2.1 Conference ........................................ 11
   2.2 Creating a Conference ............................... 11
   2.3 Setting up a Conference ............................ 12
   2.4 Conference Management Area ....................... 12
   2.5 Conference Display Area ........................... 89

3 Meetings .......................................... 105
   3.1 Meeting .......................................... 105
   3.2 Creating a Meeting ................................. 105
   3.3 Meeting Management Area ......................... 106
   3.4 Meeting Display Area .............................. 120

4 Lectures .......................................... 125
   4.1 Lecture .......................................... 125
   4.2 Creating a Lecture .................................. 125
   4.3 Lecture Management Area .......................... 125
   4.4 Lecture Display Area ............................... 135

5 Users and Groups .................................. 141
   5.1 Users ........................................... 141
   5.2 Groups .......................................... 142

6 Exporting Indico Data .............................. 145
   6.1 To Personal Scheduler Tools (Outlook, iCal, korganizer...) .................................. 145
   6.2 RSS feeds ......................................... 146
   6.3 Sharepoint ........................................ 147
   6.4 Using the HTTP Export API ......................... 147

7 Conference Room Booking .......................... 149
   7.1 Introduction ....................................... 149
   7.2 The Tutorial ...................................... 149
   7.3 Core Features and Constraints ...................... 157
   7.4 Dictionary ........................................ 159
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Event Evaluation</td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td>Introduction</td>
<td>161</td>
</tr>
<tr>
<td>8.2</td>
<td>Functional goals</td>
<td>161</td>
</tr>
<tr>
<td>8.3</td>
<td>Interface</td>
<td>162</td>
</tr>
<tr>
<td>9</td>
<td>Protection System</td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td>Introduction</td>
<td>169</td>
</tr>
<tr>
<td>9.2</td>
<td>Basic Concepts</td>
<td>169</td>
</tr>
<tr>
<td>9.3</td>
<td>Access Control Policy</td>
<td>172</td>
</tr>
<tr>
<td>9.4</td>
<td>Domain Control Policy</td>
<td>174</td>
</tr>
</tbody>
</table>
1.1 Category

A Category is a means of grouping your events or other Categories together. In Indico, Home is the top level category from where you start. Inside a category you can:

- add events or other sub-categories,
- set access rights to say who can access or modify,
- re-allocate the sub-categories,
- remove the sub-categories,
- and also delete the current category and everything inside it.

These features are accessible through the menu Manage (you must be logged in and with modification rights in order to see it), that you can find to the right of the title “Main categories”. After clicking Manage (more specifically its inner option Edit category) you will be accessing the Management area for Category.

1.2 Creating a Category

You can create a new category from the menu Manage and then by clicking on Add subcategory. You will need to have an Administrator’s account or be listed in the modification list (see Protection) for the category.

You can also create a subcategory from the Management area, which you access from the menu Manage, option Edit category. In General settings, (See General Settings) , click on the button add subcateg.
Setting the protection for your category is important. You can set it to Inheriting, Restricted or Public, see *Access Control Policy*.

### 1.3 Category overview

In the display page of the categories, the option *View > Today's events* allows you to see the category’s event overview. Events that belong to the category and its subcategories from the specified period will be displayed.

It is possible to exclude some categories from the event overview, and hence control the visibility of the events belonging to the category in *General settings (See General Settings)*. Categories have three event visibility levels:

- *Everywhere* - events are shown in the event overview webpage for this category and the parent categories.
- *Category name* - events are shown only in the overview webpage for current category.
- *Nowhere* - events are not shown in any overview webpage.
As you can see in the previous image, it allows you to see all the events happening in one specific day. You can then view the other days by clicking on the arrows on top, or by choosing the day on the calendar on the left. Underneath the calendar, you can also choose the display options. You can choose to display the events over a day, a week or a month. You can also choose the detail level: agenda will show you all the events occurring over that period of time, sessions will only display the sessions and contributions will only display the contributions.

**Calendar overview webpage** : Another option for View is the calendar view. It gives you an overview of all the events over several months. You can access it by clicking on View -> Calendar. You can see all the events happening in one specific day by pointing with your mouse on the day you wish to view (see image above). On the left menu, you can choose the number of months you wish to view (up to 12), the starting month and the number of columns displayed. You can also change to color legend.
1.4 Category Management Area

1.4.1 General settings

In the Category Management Area, the first option in the menu is *General settings*:

You can modify the details of the category:

- Name
- Description
- Timezone
- Icon
- Default style (layout) for meetings created within this category (see Meetings)
- Default style (layout) for lectures created within this category (see Lectures)
- Event visibility for this category (*See Category overview*)

and you can modify its content:

- Add a new sub-category
- Re-allocate (move to another category) some events or categories
- Remove the inner events or categories

1.4.2 Files

In this option, you can add material to a category. To do so, click on the link *Add Material*. A window will appear:
When uploading material, in the Basic tab, you can select its access protection and set it to inheriting, private or public (for more details, see Access Control Policy). In the Advanced tab, you can add a description and a display name. The display name will be used instead of the original name of the file.
1.4.3 Protection

From the Management Area you can protect your category using the three controls for access levels: Modification control, Access control and Domain control. You can add Users or Groups to the Modification and Access control lists. Conference creation control controls the users who are able to add events to this category.

Modification Control: Category Managers can be added to a category to allow access to the Management Area for modification. Category managers are either those listed in the modification control list or Indico administrators. The creator of a category will be able to modify its category without being listed.

Access Control: A category can be public, inheriting or private; Public: Anyone can view a public category and any user can add events to it. However, users will only be able to see the events inside the category to which they have access. Restricted: Only those users in the access list or administrators can access the category and add events. When a Category is made private, the option for domain control is omitted and any event or category made inside it will also be private. The category will be displayed with “(protected)” after its name to show it is private. As well, if the category access is RESTRICTED the category manager will be able to set a ‘Contact in case of no access’, so users with no access will know who to contact in order to request access. Inheriting: The category will have the same access protection as its parent category. This means that changing the parent’s protection will change the protection of the category.

Domain Control: The access to the Category can be restricted by domain. Therefore, just the users from the chosen domain will be able to access (e.g. If we choose the domain CERN, just users from inside CERN will be able to access the category and its content).
Conference creation control: You can restrict who is able to add events to the category. If you do so, you will need to add users or groups to the list in order to allow them to add events.

See Protection System in order to know more about Protection in Indico.

1.4.4 Detail Modification & Sub-Category/Event Organisation

The details of a Category can be modified and sub-categories can be organised from the option General settings in the management area. Details can be modified by clicking on modify inside the main menu. Sub-categories and events can be organised in the particular order in which you wish to view them by using the order drop down box next to each sub-category.

You can re-allocate a sub-category or event by selecting the one you wish to move using the tick box and clicking on re-allocate, you will then be asked to where you would like to reallocate this sub-category/event.

To remove a sub-category and anything it contains or an event, select it and click remove. If it contains anything you will be asked confirmation of the deletion.

1.4.5 Deleting a Category

To delete the current category you can go to the Tools menu in the Management Area and select ‘Delete this category’. There is no undo tool so far, but you will be asked to confirm the deletion first.
2.1 Conference

A conference is the most complex form of event in Indico. You should be able to manage its complete life-cycle, for instance, among other functionalities you can setup:

- a conference web portal fully customizable
- the programme definition (with themes/topics/tracks)
- a registration form with e-payment capabilities
- possibility to print badges; from the list of participants, Indico initializes badges for each of them
- abstracts to be submitted
- an abstract review process
- a timetable with many sessions and presentations
- slides and papers submission by authors
- an evaluation form in order to get feedback after the conference
- notification emails to participants
- paper reviewing

2.2 Creating a Conference

In order to create a conference, you just need to click on Create event and Create conference, in the blue bar at the top of the page. You will be presented with a form in which you:

1. choose the category where you want to place your conference
2. fill the details of the conference you wish to create
3. set the access protection of the conference to inheriting, public or private (see Access Control Policy)

Once this is done your conference will be created and you will be redirected to its Management Area. If you want to see the Home page of your conference, click on the button Switch to event page on the top right of the page.

The creator of this conference will by default have modification rights to it and is referred to as a Conference Manager as is anyone else listed in the Modification control list.
Remember that the category in which you want to create your conference must be public or you must have access rights to it.

To access the Management Area of a conference you need to click on the modification icon in the top bar of the event home page.

### 2.3 Setting up a Conference

Once your conference has been created the Conference Manager can start setting up the conference from the Management Area.

- Set up your Access Control to restrict or allow users the rights to access or modify the conference (see Access Control Management).
- Look at customizing the look of your conference when users come to view it (see Layout Management).
- Start adding Tracks to your conference to define areas to help with organisation. A Track Manager can be assigned to each track to co-ordinate which abstracts to accept into these tracks (see Programme Management).
- Starting abstract submission process. Abstracts are proposed contributions to your conference. By default, when you first create a conference, abstracts management is disabled. You can enable this in Abstracts (see Abstracts Management).
- Start looking at which submitted abstracts you wish to accept into your conference, they will then become contributions (see Contributions Management).
- Start setting up a Timetable to organize what will be happening where, and when, and what contributions, materials, etc. will be included (see Timetable Management).
- If those that will attend your conference need to register, give details concerning their needs while at the conference or pay the fees; you can set up a registration form (see Registration Management).
- There are options to clone your conference, and to perform other tasks on the whole of your conference once you set it up (see Conference Tools).

### 2.4 Conference Management Area

The Management Area allows you to control, manage, setup and modify the different parts of your conference. The following sections will show each area of the Conference Management.

Clicking on the link *Switch to event page* to the top right of the page will take you to the home page of the event.

#### 2.4.1 General Settings

From the option General Settings in the left menu you can:
• **Title**: Title of the conference.

• **Description**: The description that will appear on the event page.

• **Place**: Edit the location, address and room of the conference.

• **Start/End Date**: Edit the start and end dates of the conference.

• **Timezone**: Timezone of the conference.

• **Additional info**: Additional information that will appear on the event page overview.

• **Support**: Modify the support email along with the caption. This will change the support email link located at the bottom of the menu that is displayed on the homepage of the conference (see Conference Display). You can specify more than one email address for the support. Just make sure of separating each of the addresses by a comma (",").
2.4.2 Timetable Management

You can organise your conference from the Timetable tab in the conference management area. When you start with a timetable it will look like this:

- **Default style**: Choose the default layout style for the timetable.
- **Visibility**: This changes the visibility of the event in the events overview. If you choose everywhere, the event will be visible everywhere. Choosing a category will make it visible only in the category's events overview. Choosing nowhere means that the event won’t be visible in any events overview, see *Category overview*.
- **Event type**: Changes the event type. You can choose between lecture, meeting and conference. The difference lies in the different features which are accessible to you. A conference has more features than a meeting, a meeting has more features than a lecture.
- **Keywords**: Keywords of the conference.
- **Short display URL**: Create a URL shortcut to the event page, for instance: http://indico/event/my-conf
- **Chairpersons**: Add or remove the chairpersons of the conference.
- **Screen dates**: Set the Screen dates. These are the dates that will be displayed in the home page of the conferences. The screen dates are useful when we want to have different dates in the display than in the timetable.
- **Types of contributions**: Create all the types of contributions for your conference, for example, oral presentation and poster. This contribution type can be chosen for any abstracts or contributions added to the conference.
You can modify the start and end dates of the timetable, and you can start adding sessions, breaks, and contributions to your timetable.

In order to edit the entries in the timetable, you just need to click on the entry box and edition balloon will show up.

**Sessions**

A session is essentially a time interval within which you organise many presentations of your conference. You can create sessions based on different reasons:

- You could use a session for each track, for example.
- There can also be more than one session scheduled at the same time (parallel sessions).

To create a new session, click on *Add new* and *Session* at the top right of the timetable. When doing so, you have the option to create a new session or add a block to an already existing session (if there is already at least one session in your timetable).
• Create a new session: You will need to give it a title, choose the duration and a date and time. You can then complete the following criteria (optional): you can add a description, change the location, add conveners etc.

• Add another block to: You can choose to add another block to an already existing session. You will first need to choose to what session you want to add a block. You can then choose the time, date, location, add a convener, etc. This means the same session will be happening in different time intervals. For example, you can have a morning interval, then a break, then an afternoon interval within the same session. Another example is having a session on a particular subject one day, and on another subject a few days later.
Session Blocks

A session can happen in different intervals of time. If you already have a session (which will be like the first block) and you want to add more blocks for that session, you can do it from the menu (in the top bar of the timetable) Add new -> Session -> Add another block to: an already existing session.

However, this is optional, blocks can be used when the session takes place over more than one period of time. For example, you may have a morning block, then a break, and then an afternoon block within the same session. Also, you may have one day you have a session on a particular subject for a couple of hours and then two days later you may have another session on that subject.

Adding Breaks to a Timetable

To add a break to your timetable, use the menu Add new -> Break at the top right of the timetable. You will be presented with a form where you can modify the name, description, date and time of the break. You can also modify the address where the break will take place and the color in which it will appear in the timetable. Once the break is created it will appear in your timetable.
In order to modify your breaks, you need to click on the entry and an edition balloon will be displayed. Click on Edit to access the edit menu. By doing so, you can edit all the informations entered in the form when you created the break. If you quickly want to modify the duration or location of the break, click on the pencil to the right of **Duration**, **Room** and **Location**. You can also click on **Move** in the edition balloon. From this option, you can choose to move the break, inside a session or to another day.

If you delete a break, unlike a contribution, it will not remain anywhere. You will however be asked to confirm deletion.

**Adding Contributions to a Timetable**

To add a contribution to your timetable use the option *Add new > Contribution*. Here, there are two possible situations:

1. If there are already some unscheduled contributions (*see Contributions Management*), Indico will show a list of the contributions in which you select the one(s) you want to add. You can also choose to create a new one.
2. If there are no unscheduled contributions, a form for the creation of a new contribution will appear.
If you choose to delete a contribution and this contribution has been created/added from the Contributions option on the left menu, then it will be deleted from the timetable, but will remain in the contributions list under the Contributions option.

To edit a contribution:

Click on the entry in the timetable, an edition balloon will show up. You then need to click on Edit. You will be redirected to the contribution’s page, where you have six tabs, where you can edit the main options, the material, the sub-contributions, the protection, the tools and the paper reviewing. You can also choose in the edition balloon to Move the contribution. This allows you to move the contribution, into a session, or to another day.

Session Management

You can access the Management area for a session from the edition balloon (this is the balloon that appears when clicking on the entry), by clicking Edit > Session properties.
This new page will allow to modify everything within that Session. You will see different tabs from which you can:

- Edit the general settings.
- Manage the list of contributions for that session.
- Modify the inner timetable for that session.
- Write some comments that other session coordinators can read.
- Attach files.
- Set its protection and the coordinators (people with rights to schedule talks).
To edit a session, click on its entry in the timetable and an edition balloon will show up. From this, you can add a new block to the session (which you can also do by clicking on Add new -> session -> Add another block to). You can delete the session, but please note that if you do so, it will not remain anywhere else, unlike contributions. You will however be asked to confirm deletion first. From the edition balloon still, you can change the color of the entry in the timetable, or change the duration and location of the session by clicking on the pencil to the right of Duration, Room, Location. By clicking on Edit in the edition balloon, you have three options that appear.

- **Block timetable**: You can edit the timetable of this block, i.e. you can add contributions and breaks inside the session itself
- **Block properties**: You can edit all the information given when you created the session. You will be presented with exactly the same form
- **Session properties**: You will be presented with six tabs: main, contributions, session timetable, comment, files, protection and tools. All these tabs are explained below

### Main Tab

From the Main tab in Session you can modify the general session information. You can modify the code, title, description, default place, default duration and layout (in the timetable) of the session. You can also add/remove any conveners.

In this tab, all the default values will be used as default values when creating a new block for the session. This default values are taken from the creation of the first block for the session.

### Contributions Tab

From the Contributions tab you can see all the contributions that are part of your session. These contributions will only be shown once they have been added (see Adding Contributions to Sessions). Here, you can also add contributions to your session. If you know the contribution’s ID, you can make use of the Quick search option; type in the ID, and then click on seek it. Otherwise, you can search for it. You can search by author, or by any of the filtering criteria. It is also possible to import a contribution, to get the PDF or author list of selected contributions. You can also remove contributions, by selecting them and then clicking on remove selected.

### Session timetable Tab

Each session can have an inner timetable. You can add new blocks, contributions and breaks inside this timetable.

### Files Tab

This is the tab where you can view all the material belonging to the session. You can add, remove, edit or delete any material.
Protection Tab

From the Protection tab in Session you can set the access rights for modification, access, and domain control in the same way as you can for the conference (see Protection Management). The only difference is the Co-ordination control in which you can assign someone to be the Co-ordinator, which means they can add and remove contributions and breaks to the timetable of that particular session.

Tools Tab

From the Tools tab in Session you can delete, close the session or write minutes for it.

Adding Contributions to Sessions

Inside sessions, you can create new contributions from the timetable or add unscheduled contributions (which have already been created and will be placed in the timetable later on). Here, we will see how to add/import contributions that have already been created.

To add contributions to a session you first need to import them from the main conference. To do so, use the Contribution tab inside the session:

Click on import contributions, this will take you to a screen where you can select the contributions you want to include in your session.
Once you have selected the contributions they will appear inside the Contributions tab in the session. You can then use the option Add new > Contribution from the Session timetable and select from the contributions you imported. When you have added a contribution to your session timetable you can edit the times, duration, room and location by clicking on the contribution box.

Room Booking

If there are rooms booked for the conference they will be shown at the top of a selection list during creating/editing sessions, slots, breaks and contributions. If the name of the booked room is green, it means it is not used in any other event in the current conference. Otherwise the name will turn red and information about event using this room will be shown while pointing this name.
Rescheduling

This option is available on the top right of the timetable, to the right of the option *Add new.*

Step 1: Choose the type of rescheduling you want

- Adjust time of all entries will move all the entries in the specific days by changing their *starting times.* The first entry will start when the event starts and the other will follow consecutively after it. The durations will not be changed.
Adjust duration of all entries will adjust the duration of the entries of the selected day to fill the gaps between them, so that their starting times don’t change. If a gap time is specified, the duration will be extended up to the value of this time gap before the starting time of the next entry.

Step 2: Choose the time gap between entries
You need to type a duration in minutes

Step 3: Choose to fit sessions to their content
You can choose to tick the option to fit all the sessions contained in the specific day to their content. This will change the start and end times of the session blocks occurring on that specific day in order to fit their respective content before performing the rescheduling.
Drag & Drop

You may also manipulate existing entries in the timetable by interacting with them directly using your mouse pointer, various functions are available to you whilst using this tool.

Moving a Contribution, Break or Session

By clicking on the desired contribution, break or session slot and dragging it around the timetable area, you will notice that the selected item moves with your pointer whilst showing where the new start time will be once the movement ends.

The proposed new start time of the item item is displayed to the left whilst dragging it.

Upon releasing the mouse button, the item dragged will have its start time (and, subsequently, its end time) altered to where it has since been positioned.

Note: The duration of the event is not modified in this operation.

Moving Multiple Contributions, Breaks or Sessions

Whilst performing a move of a contribution, break or session item, as denoted above, you may also hold the **SHIFT** key to modify all following contributions, breaks and sessions with the same difference applied to the item being dragged.

For example, if you were to drag a contribution starting at 10:00 to start an hour earlier at 09:00 and the **SHIFT** key was held, the difference of one hour earlier would be applied to all (and only) contributions and sessions of the same day.

Changing Contribution, Break or Session Duration

Positioning your pointer at the lower edge of any contribution, break or session item will display the resizing cursor, clicking here and dragging the line in an upward or downward direction will alter the end time by decreasing or
increasing the item’s duration respectively.

Moving a Contribution or Break into a Session

It is possible to move a contribution or a break into a session slot by simply dragging the contribution/break in question over the session slot into which it is desired to go.

Once the contribution/break is over the session slot, the contribution’s (break’s) size will change to indicate that it may be moved into the session slot designated. Simply releasing the mouse button will commit the action and perform the move.

Undo Action

As all interactions performed via the drag and drop interface are instantly written to Indico, the facility exists to Undo any incorrect action simply by pressing the *Undo last operation* button which appears at the top of the timetable following any such action.
Upon clicking this button, the previous action will be totally reversed and you may proceed to continue with the originally intended action.

Note: The undo function supports only the last operation applied, you cannot step through this session’s interaction history with the button.

### 2.4.3 Material Management

This is where you upload and manage the material attached to the conference. The material can be minutes, papers, posters, slides, etc. You can control the access protection of the material by choosing it to be public, private or inheriting (see *Access Control Policy*).

### 2.4.4 Programme Management: Tracks

From the *programme* option (on the left menu) you can add/remove tracks and access each of them by clicking on their name.
Tracks are parts of the conference to which abstracts and contributions can belong. For more on tracks, see `indico_glossary` (section about tracks).

Inside tracks you can do the following:

- **General settings:**
  - Modify the Code: a code can be used if you prefer to use codes as opposed to long titles. These codes will be used in listings for contributions and abstracts.
  - Modify the Title and the Description of the track.

- **Coordination Control:** Assign Track Manager(s) who can propose what is accepted into their Track. Track Managers do not have modification access to the rest of the conference, they only have access to the modification of their Track, see `track_coordinators_guide`
• Abstracts: Show any abstracts which have been submitted to the Track, the Track Manager can then propose to accept or reject it. Only the Conference Manager can have the final say in whether an abstract is accepted or rejected (see Abstracts Management).

• Contributions: Show any contributions that belong to the Track (see Contributions Management).
2.4.5 Registration Management

You may wish to have some kind of registration process for those attending your conference. Here you can give the registrants options such as accommodation or any specific needs. The Registration Management comes in two parts: the Registration Form and the Registrants.

These are the steps in the registration process:

1. The conference manager enables the registration. To do so, go on the Registration option in the left menu, and click on the button Enable. He can set the registration deadline, the maximum number of participants, to set e-mail notifications etc. (see Setup tab).

2. The registrants apply for participation. To do so, they fill in a form that is found on the event’s page.
This form is set by the conference manager (see below). He can choose all the options that will be available to registrants, such as social events, accommodation etc. The conference manager will have the option to make certain events billable (such as lunches, expeditions organized within the conference etc.) and then to enable the e-payment. E-payment can be enabled in the Registration option in the left menu, under the tab e-payment (see E-payment).

3. The conference manager has access to the final list of participants, which he can manage.

4. Once the list of participants has been established, Indico automatically generates printable badges for each participants. The conference manager can customize them by going to the tab Registrants, selecting registrants and then clicking on Print badges (see Registrants, section Print badges), sending emails, exporting to excel, pdf, etc.

2.4. Conference Management Area
Registration Form

You can access the registration module from the option *Registration* in the menu on the left.

Setup tab

From the Setup tab you can control the main features of the registration form: enable or disable the registration, modify the period of registration, the maximum number of registrants you will take, any announcements and if you wish to receive an email when a new registrant applies. Click on *Modify*, on the right side of the setup tab, to access the configuration page.

The last part of this tab is *Custom statuses*. This is the status of the registrant; you can add or delete statuses.

Here is an exhaustive list of the parameters that can be configured:

- Current status: this is where you enable/disable the registration.
- Registration start/end date: choose the registration start and end dates. You can also allow late registrations by choosing *Allow x days/weeks late*.
- Modification end date: If you want the registrants to be able to modify their registration after the end date of the registration, you can set a modification end date.
- Title: you can change the title of the registration form.
• Contact info: Type here any information you wish to appear under the option Registration in the event page.

• Announcement: You can enter any announcement that you wish to appear in the registration form.

• Max no. of registrants: You can limit the number of users who can register for your conference.

• Email notification sender address: The FROM address that will appear in any email notification sent.

• Email notification: If you wish a notification to be sent when a registration is submitted, enter here the addresses of the persons you want to receive the notification.

• Email registrant: Choose when/if to email a registrant (e.g. after registration, after successful payment etc).

• Must have account: You can choose if the registrants to your conference must have an account or not to be able to register.

### Edit tab

Within this tab resides all edition capabilities of the registration form content. You will be presented with an interactive editor of the registration form. Whatever change you make on it, it will be instantly saved.

The registration form is organized in sections. Each one is an essential part of the registration form, and it may contain several fields to be filled in by the user later on. The edition view allows you to edit, disable, recover and sort sections, create new ones, and delete them. Also, they can be expanded and collapsed to have a more comfortable view.

The first thing you will find above the sections is a floating toolbar with buttons to create new sections, recover disabled ones (if applies), and extend/collapse all. In order to modify the order of the sections, if you grab the 3 horizontal
dots on the upper part of the section box, you can drag and drop it to the desired location. Should you need to finally dispose of any custom section that is disabled, you can do so from within the recover sections dialog.

In the header of each section you can modify the title and description simply by clicking on the text to start editing it and saving it by pressing ENTER. On the right side there are some buttons that allow you to add new fields, open the configuration dialog, disable the section, or collapsing/extending it. Please, note that not all the sections allow the same actions, as some don’t accept new fields or can’t be disabled nor have further configuration options. Some of their peculiarities are as follows.

- **Personal Data**: Personal data registrants will be asked. Any number of fields can be added. There are several types of fields available from the Add Field button, covering the most common use cases. Also, these fields will have the option to be billable, meaning that they can have a price attached. Therefore, the form can be used with an online payment system.
A highlighted field can be removed, disabled and configured by clicking on the icons that appear on the right side. Depending on the type of field, different options will appear in the configuration dialog. Disabled fields will be moved to the bottom of the section and they won’t be displayed in the registration form. You can sort the fields by grabbing the 3 dots on the left side of the row and drag & dropping it on the desired location. Here is an example of how it looks a configuration dialog.
• **Reason for Participation**: The Reason for participation form allows you to ask the registrant why he or she wants to participate. From this page you can modify the question and title of the form.

  ![Reason for participation form](image)

• **Sessions**: The Sessions form allows you to add which sessions from your conference you would like people to register for. From the form you can also change the title, description, and the type of session’s form (2 choices, they can choose just two sessions; multiple, they can choose any session).

  ![Sessions form](image)

• **Accommodation**: The Accommodation form lets you add or remove the different types of accommodation available to your registrants. You can also add a maximum number of places, price, etc.

  ![Accommodation form](image)

• **Social Events**: The Social Events form allows you to add/remove any social events for which registrants can sign up. When you add an event you need to add the title of this event.

  ![Social Events form](image)
• **Further Information**: The Further Information form gives you the opportunity to add any additional information for the registrants.

![Further Information Form]

• **General Sections**: These are custom sessions created by the manager of the conference. As with the *Personal Data* section, you can add as many fields as needed.

---

**Registrants**

The Registrants tab will show a list of all the registrants for your conference.

![Registrant Table]

From this list you can perform several actions on the registrants, as for example:

- **Add new**: It will open the registration form *(see Registration Form)*.
- **Remove**: It will remove the selected registrants.
- **Check in**: It will mark the selected registrants as checked in. *(This option is only available if the e-ticket module is enabled)*
- **Email**: It will allow to send an email to the selected registrants. Indico will send one email per participant. Also, you can profit from the Available tags to make it personal; Indico will replace the tag with the real value of the registrant, e.g. `{registrant_family_name}` will be Smith.
• **Print badges**: It will open a new page that will allow you to print the badges of the selected registrants.

![Compose the email](image)

You may then select which template you wish to use for your PDF by selecting the radio button to the left of it.
and then clicking ‘Download Badges PDF’. You also have the option to edit, clone and delete the templates you have stored at will.

Furthermore, clicking the ‘PDF Layout Options’ button provides access to further fine-tune your badges before downloading:

- **Show stats**: It will show the statistics about the registrants.
• **Export -> CSV**: It will create a CSV file with the selected registrants and the columns displayed.

• **Export -> PDF**: It will allow you to create a PDF in two styles: *Table style* and *Book style*. If you want to print a large quantity of fields the *Book Style* is recommended.

Also, beware that clicking on *Select All* or *None* will select or unselect all the registrants checkboxes.

Moreover, clicking on the registrant’s name will show you all his details and the information he provided in response to the form’s questions. And you can also modify them.

Additionally, if the e-ticket module is enabled an e-ticket tab will be shown. Where you can download the generated ticket for this registrant, as well as mark/unmark him as checked in.
E-payment

You can choose to enable or disable e-payment by clicking on Enable/Disable. From this tab, you can customize the text to display in the payment page, the payment conditions, the email bodies related to e-payment and the currency to use. See in the image below all the options.
E-ticket

You can choose to enable or disable the e-ticket module by clicking on On/Off.

Once enabled, Indico will be ready to generate a unique electronic ticket for every participant. The e-ticket is a PDF document containing a QR code that can be used to check-in attendees at the Conference Registration Desk. In order to read the QR codes, Indico provides a mobile app named ‘Indico check-in’ that will list all the registrants and provides the necessary tools to check them in.

Managers can choose how Indico will distribute the e-tickets. Currently, there are three options:

1. The e-ticket can be attached to the email sent to the user after registration.
2. The e-ticket can be downloaded from the conference homepage menu.
3. The e-ticket can be downloaded from the summary page right after registration.

2.4.6 Abstracts Management

The Abstracts option has 5 tabs:

- Setup: Where you can enable/disable the abstract submission process, change the start/end submission dates, set a modification deadline, enable email notifications etc
- Preview: Preview of the submission form, with the content, the author and co-author, but also other options such as track classification etc.
- **List of Abstracts**: Display the list of abstracts. Here you can add/delete abstracts, apply filters in order to view certain abstracts only etc.
- **Book of Abstract Setup**: Where you can customize the book of abstract and print it too
- **Reviewing**: Where you can set questions, assign reviewers by track and set notification templates

See below for more details about each tab, *Abstracts Setup*

---

### Abstracts

The Abstracts process works in the following way:

1. **The event organizer needs to enable the abstract submission process.** You can do this in the *Abstracts* option, in the tab *Setup*; see *Abstracts Setup*

2. **All the authors submit their abstract.** To do so, they need to go to the event page. If the abstract submission process has been enabled, under the *Call for Abstracts* option there will be a sub-option *Submit a new abstract*. Click on this link, complete the form and then click on *Submit*. The abstract will need to belong to a track if you want to use the review process

3. **The abstracts are now reviewed by the track coordinators.** Each Track Coordinator has a list of abstracts to review. He will propose to accept, merge or reject each abstract

4. **The final decision belongs to the event organizer.** He will decide whether to confirm the track coordinator’s decision or to do otherwise

---

2.4. Conference Management Area
Abstracts Setup

The different tabs are explained below:

Setup

The options you can find inside the setup tab are the following:

- **Current status**: From here you can enable and disable the abstract submission
- **Dates**: Choose the submission start and end dates
- **Modification deadline**: You can let the users modify their abstract after they’ve submitted it. You can choose the modification deadline to be after the submission end date, which means the users will still be able to modify their abstract (once submitted) after the submission deadline
- **Announcement**: Any comments you wish to make that will appear in the event page under the option *Call for Abstracts*
- **Email notification on submission**: An email message is automatically sent to the submitter after submitting an abstract. You can specify other email addresses you wish to receive a notification
- **Late submission authorised users**: If you want, you can allow certain users to submit their abstracts after the deadline.
- **Misc. Options**: Other options available, such as enable/disable multiple track selection
- **Abstract fields**: The fields that will appear in the form to submit abstracts. You can add more and also select the order in which they appear.

Different types of abstract fields can be added by clicking in the *add* button.
Fields can be configured at creation time or at any moment by clicking on the name of the field. These dialogs will appear. For changes to take effect the *add/update* must be clicked.
Preview

Click on this tab to get a preview of the abstract submission form. Feel free to try this form, any submitted abstract from this tab will not be recorded.

List of Abstracts

The List of Abstracts tab shows all the abstracts that have been submitted to the conference:

- **Quick Search**: If you are looking for an abstract and know its ID, type it in the box next to Abstract ID and click on seek it; this will get you directly to the abstract you are looking for.
• **Apply filters:** Clicking on this link will open a box with many filters. Enabling or disabling any of them will have an impact on the abstracts shown in the list below. For example, you can choose to display only the abstracts belonging to a particular track or session.

• **Columns to display:** Clicking on this link will open a box with the columns to display for each abstract.

• **Add New:** Submit a new abstract. This will bring you to a page similar to the one any user will see. For further information about the abstract submission form, please see *Submitting an Abstract*.

• **Accept:** If you have the correct rights, you can accept abstracts (if not, you can only propose to accept). Tick the corresponding box, and then click on *Accept*. A new page will appear, where you can choose the destination track, session, the type of contribution and if you wish to send an email notification or not. Once you have chosen all the options, click on *accept*.

---

**Accepting 1 abstracts**

*Click here to see the list of the abstracts you are accepting*

- Comments
- Destination track
- Destination session
- Type of contribution
- Email Notification

Click **accept** or **cancel**

---

**Rejecting 1 abstracts**

*Click here to see the list of the abstracts you are rejecting*

- Comments
- Email Notification

Click **reject** or **cancel**
• **Merge**: If you have the correct rights, you can merge abstracts (if not, you can only propose to merge). Tick the corresponding box, and then click on *Merge*. You will need to specify the abstract IDs to be merged and the target abstract ID. You can choose to include authors in target abstract and whether to send or not an email notification. You can also add comments. Once you have completed this, click on *submit*

![Merging abstracts](image)

- **Author List**: You can get an author list for the abstracts. You first need to select at least an abstract, by ticking the corresponding boxes. A list will then be displayed showing the submitters, primary authors and co-authors.

- **Export to**: You can export the abstracts of your choice. You can choose between XML, PDF or Excel

You can also access each abstract by clicking on its name (*see Abstracts*). An abstract can be in one of 10 states:

- **Submitted (S)**
  - Abstract has no judgement yet.

- **Under Review (UR)**
  - Abstract has at least one judgement but not for all tracks.

- **Proposed Acceptation (PA)**
  - Abstract has at least one judgement for each track and exactly one track has all proposals for acceptance.

- **Proposed Rejection (PR)**
  - Abstract has at least one judgement for each track and there is proposal for reject and there are no proposals for acceptance.

- **Accepted (A)**
  - Abstract has been accepted.

- **Rejected (R)**
  - Abstract has been rejected.
• Withdrawn  
  – Abstract has been withdrawn.

• Duplicated  
  – Abstract has been marked as duplicated.

• Merged  
  – Abstract has been merged with another.

• Conflict  
  – Abstract has at least one judgement for each track and there is more then one track proposed for acceptance.
  – Abstract has different judgments within at least one track (e.g. one reviewer proposed to accept abstract and another proposed to reject it).
  – Reallocation proposals are in conflict for the abstract.

---

**Book of Abstracts Setup**

From here you can customize the book of abstract:

• Additional comments for the first page.
• Enable showing Abstract ID in the table of contents
• Sort by id, name, session, etc

You can also generate the PDF Book of abstracts.

Also, this is PDF file will be available from the conference home page *(see Conference Display)* containing all the abstracts, unless you disable it from the Layout menu, the Menu tab.

---

**Reviewing**

• **Settings**: You can add questions you wish abstracts reviewers to answer, the number of answers per question and the scale for each answer (e.g. 1 to 10). There is also a preview of the question box on the left.

• **Team**: This is where you assign reviewers to each track. Click on *Add Indico User*, a search box will appear. Search for the user(s) you wish to add, select them and click on *Add*.

• **Notification Template**:

A notification template is an email template that the conference organizer can pre-define and that will be automatically used by Indico under certain circumstances (when an abstract is accepted, rejected or merged).

In order to create a Notification Template you have to:

• Go to *Abstracts* menu, click on the tab *Reviewing* and then on the option *notification templates* beneath it.

• Click on the *add* button and fill the form as following:

**Step 1:**

• Title: title of the notification template.
• Description: write a description of the notification template.

Step 2:
• From address: the FROM address in the automatic email.
• To address: who will receive the notification. You have to choose between the submitters and the primary authors, or both.
• CC addresses: additional people who will receive the notification
• Subject: subject of the notification
• Body: body of the email. You can customize the body by adding special tags on it. This tags will be replaced with the information of the abstract like: title, id, URL, submitter family name, etc. Be careful to write perfectly the tags or the email will not work.

Step 3:
• Choose the condition that triggers the email. This can be if it is in status ACCEPTED, REJECTED or MERGED.
• Click on the save button.
• If the condition is ACCEPTED, you need to specify if this applies to any contribution type and track, none, or a specific one, and then click on the button submit. Click on preview to preview the template.
• If the condition is REJECTED or MERGED, or if you have done step 3, you are finished. This template will be sent under condition chosen at 2.3.1. Therefore, Indico will automatically send the email when accepting, rejecting and merging abstracts.

Abstracts
An abstract is either submitted by an author or manually added by a Abstract Manager (conference organizers). It is then reviewed by the track coordinator of the track it belongs to. The track coordinator will propose to accept, reject or merge the abstract. If it is accepted, it will automatically become a contribution, (see Contributions Management), which you can then place in the timetable (see Timetable Management). Here are the different tabs:
• **Main**: From here, you can change the main information about the abstract such as the author, co-author, contribution type etc. The Conference Manager can change the status of an abstract, for example, by accepting it or marking it as a duplicate.

• **Track judgments**: Any comments made by the Track Manager or Conference Manager while changing the status of the abstract can be viewed from this tab.

• **Internal comments**: Here, conference organizers can add any comments they may have about the abstract.
• **Notification log**: A notification log, with the emails sent to the author, can also be viewed from inside this tab

• **Tools**: From here, you can delete the abstract

### Back to submitted

When the abstract has been accepted or rejected it exists the possibility of undo the action and come back to the status **Submitted**.

It will be shown the button *back to submitted* in order to make the action.

In case of the status **Accepted**, a popup will open in order to confirm the action because the associated contribution will be deleted.

#### 2.4.7 Contributions Management

The Contributions menu shows all the contributions to the conference. These may be either accepted abstracts or abstracts added by the Conference Managers.

From the contribution menu you can:

• **Apply Filters**: Clicking on that link will open a list of criteria which allows you to filter the contributions. For example, you can choose to only display contributions included in one specific track or session.

• **Static URL for this result**: Gives you the URL to access this page with the filters that you have applied until that moment.
• **Add new**: Add a new contribution.

• **Delete**: Delete the selected contributions. Beware that once deleted, you cannot restore them.

• **Move**: Assign one or more specific contributions to a session.

• **Author list**: This will show you a list of the primary authors, the co-authors and presenters. You need to select at least one contribution before clicking on **Author list**.

• **Material package**: This allows you to export all the material from the contributions into a zip file.

• **Proceedings**: Get a zip file with all the papers and a table of contents. To generate this, the conference organiser should go through all contributions, and mark the wanted papers as main resource (click on the ★ icon. When the star is yellow, the material is marked as main resource). Once this is done, Indico will generate a table of contents for all the papers and organize all PDF files by chapters into a zip file.

• **PDF icon**: This will create a PDF of the contributions in the three following ways: you can export it as a contribution list (which contains more details), as a book of abstracts with less details or as a book of abstracts which is sorted by board number (useful for posters). To select a contribution you wish to export, you must first tick the corresponding box (clicking on the name will redirect you to the contribution’s page) and then on the PDF icon.

---

**Contributions**

Each contribution has its own management area.

From inside the Main tab you can:
• Modify the main details of the contribution, for example, name, duration, etc.
• Change the track to which this contribution is assigned.
• Change the session in which this contribution is included (see Timetable Management).
• Add/change authors and co-authors.
• Add/change the presenters of the contribution.
• Withdraw the contribution from the Conference.

From the Material tab you can access the material of the contribution and add or remove documents (see Material).
From the Sub-contributions tab you can:

- Add/remove a sub-contribution.
- Change the order of sub-contributions by using the drop down priorities.
- Access each sub-contribution by clicking on its title (*See Sub-contributions*).

From the Protection tab you can:
• List the users that can submit material (see Material) to the contributions. By default nobody can submit material, it needs to be specified.

• List the users that can modify the contributions.

• Make the contribution Public, Restricted or Inheriting (see Access Control Policy):
  
  – Public: Any user can view (not modify) the contribution.
  
  – Restricted: Only users listed in the access/modification/submission control can access the contribution.
  
  – Inheriting: It will have the same access protection as its parent event. Changing the access protection of the parent event will change the access protection of the contribution.

• List the domains (e.g. CERN domain) that can access the contribution (this is only available if the contribution is public)

From the Tools tab you can:
• Delete the contribution.
• Assign the contribution to a session
• Write the minutes for the contribution; these will be attached to the material for the contribution (see Material).

Sub-contributions

Sub-contributions can be added to a contribution to organize the contribution further.

From inside each sub-contribution you can modify the general details, add or remove presenters, and attach material in the same way as you can for contributions. From the Tools tab in a sub-contribution you can delete that sub-contribution or write the minutes for it; these will be attached to the material for the sub-contribution.

Material

Material can be submitted by a user once the abstract has been accepted and made into a contribution. Material can also be added by the Conference Manager directly to the conference, or to a contribution or sub-contribution.

You can upload files or simply add URL links.
• **Location**: Choose the type of location of your file and upload it

• **Material type**: Select the material type (e.g. slides, poster etc.)

• **Access Control**: Choose the protection for the file. You can choose between inheriting, public and private; for more information, see *Access Control Policy*

Access rights can be set for each material. From inside Access Control you can list those users that can view the material.
Protection:

- **Allowed users and groups**: When you set the material to be private, enter there the users or groups that are allowed to consult it.
- **Visibility**: Set the visibility of the material (see *Category overview*).
- **Access Key**: You can choose to protect the material with an access key. This means anyone who has the access key has access to the material.

Advanced:

- **Description**: You can enter a description of the material.
- **Display Name**: You can choose a display name for the material you upload. This name will be showed instead of the file name.

### 2.4.8 Paper reviewing

When you click on this option (and if you haven’t chosen the type of reviewing yet) you will see this:
You will therefore need to choose a type of reviewing process. There are four options:

- **No reviewing**: This means the conference will have **no reviewing process**.
- **Content reviewing**: This means only the **content** of the contributions will be reviewed (and not the layout). You will only be able to appoint Referees and Content reviewers.
- **Layout reviewing**: This means only the **layout** of the contributions will be reviewed (and not the content). You will only be able to appoint Layout reviewers.
- **Content and Layout reviewing**: This means both the **layout** and **content** of the contributions will be reviewed. You will be able to appoint Referees, Content reviewers and Layout reviewers.

For more information about:

- Referee, see referee_guide
- Layout reviewer, see layout_reviewer
- Content reviewer, see content_reviewer

**Content reviewing**

- Setup tab
This is where you set up the options for the content reviewing. Here, you can add your own statuses, questions that referees must answer, set default deadlines, set automatic email notifications and upload templates.

- Team tab
Step 1 - Assign managers of paper reviewing

An automatically generated e-mail will be sent to newly assigned Paper Review Managers. You can modify this from the Paper Reviewing Setup.

Managers
Responsibilities: Setup, assign contributions to Referees, define team competences

Add Existing

Step 2 - Assign Reviewers

Referees
Responsibilities: Assign contributions to reviewers and give final judgement

Add Existing

Content Reviewers
Responsibility: Judge content verification of contributions

Add Existing

Once this step is done you may want to assign competences for the members of the team. Please click on the next tab Competences to continue the process.
This is where you can assign managers, referees and content reviewers.

- Competences tab

![Team competences tab](image)

To define competences for each user could help you to choose better the user when you assign contributions.

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
<th>Responsibilities</th>
<th>Competences</th>
</tr>
</thead>
<tbody>
<tr>
<td>45130</td>
<td>COSTACHE, Anamaria</td>
<td>Content Reviewer</td>
<td></td>
</tr>
</tbody>
</table>

Knows mathematics.

Once this step is done you may want to assign papers to review. Please click on the next tab Assign Papers to continue the process.

Here you can define competences for each user. This can be helpful while assigning contributions.

- Assign papers
Here you have a list of all the contributions and their information. Depending on your role, you can assign them to reviewers (referee) or remove them (manager).

### Layout reviewing

- Setup tab
This is where you set up the layout reviewing. You can add the questions that must be answered by the layout reviewers, set the default deadlines for the judgments, set automatic email notifications and upload a template.

- Other tabs

See Content reviewing

---

Content and Layout reviewing

This is where you set up the reviewing for the conference. The tabs contain all the options described above put together; see Content reviewing and Layout reviewing
2.4.9 Chat room

See *Chat room* in Lectures.

2.4.10 Video Services

See *Video Services* in Lectures.

2.4.11 Evaluation

You can set up an evaluation form to be completed by the participants. To enable/disable, click on *Show/Hide*. For more on the evaluation process, see *Event Evaluation*.

This area gives you access to all the lists of pending users, dependent upon their pending actions. The default view presented is that of all contribution speakers.

2.4.12 List Management

**List of all contributions’ speakers**

You are again presented with the corresponding list of users. You can send e-mails to selected users.

![List Management](image)

The same options are available in the three different tabs.
Pending people to become Indico users

By clicking on this link, you will be presented with 3 tabs: Pending Submitters, Pending Managers and Pending Coordinators. In each of them, you will find a list of the corresponding users. From these tabs, you can remove selected users or send reminders.

List of all sessions’ conveners

You are presented with a corresponding list of users. You can send e-mails to selected users.

2.4.13 Protection Management

Protection in a conference is similar to that in a Category (see Protection). There is Modification Control, Domain Control and Access Control. When adding to the Access and Modification lists, you can also add Groups of users if any have been defined by Administration.
Modification Control

Only the Managers listed in the Modification Control, the Creator of the conference, and any Administrators can access the Management Area of the conference. However, you can add a Modification Key which means anyone with this key can modify the conference without logging in.

Access Control

When the conference is public, anyone can view the conference including the programme, timetable, abstracts, etc. When the conference is private, only those in the Access List, Conference Managers and Administrators can view the conference. When it is inheriting, it will have the same access protection as its parent category. Changing the parent’s access protection will change the conference’s access protection accordingly; see Access Control Policy.

If the conference access is RESTRICTED the event manager will be able to set a ‘Contact in case of no access’, so users with no access will know who to contact in order to request access.

Restricted events can have an Access Key, meaning that anyone with this key will be able to access the conference without logging in. Users will see a message such as the following:

Accessible from everywhere

To restrict access to this event only to certain IP addresses, choose at least one of the networks below.

Tools

Session coordinator's rights

Restricted session timetable management (add contributions, create breaks)
View contributions from the conference manager (no modifications)
View contribution list (no modifications)
View session main data (no modifications)

Optional Rights

(Click on the icon in order to enable/disable)
Modify the contributions
Unrestricted session timetable management
Whenever an event contains elements (sessions, contributions, ...) that have different protection statuses (i.e. the event is private but there is a protected element within, or conversely) a corresponding warning message will be shown.

*Domain Control* This option is only for public events. It allows to specify which domain (e.g. CERN) can access the conference. Therefore, only users from inside this domain will be able to access.

*Session coordinator’s rights* This informs you of the basic rights which are always available, and allow you to modify the optional rights the session coordinators have.

---

### 2.4.14 Conference Tools

The conference Tools allow you to carry out certain actions on the whole of the conference.

---

**Alarm Control**

You can set an alarm/reminder to alert people about the conference; the alert will be in the form of an email. To do so, click on the button *add new alarm* in the *Alarms* tab.
Clone event

Clone the conference if you would like to make another conference exactly the same. You have the option to clone it once, at fixed intervals, or on certain dates. You must clone a conference in two steps:

Step 1: Choose what to clone

Firstly, you need to choose what you wish to clone, i.e. the attached material, the tracks, the alerts etc. To choose any of this options, tick its corresponding box

Step 2: When to clone

You have three possibilities:

- Cloning the event once: If you only need to clone the conference once, do Step 1 and then choose the date on which you wish to have another conference as this one, then click on *clone once*.

- Clone the event with a fixed interval: If your event is regularly occurring, then you can choose this option. You have the choice to clone it every $x$ weeks, months or years. To determine the number of times the conference will be cloned, you can choose a start and end date (e.g. every 3 weeks from 01.01.2012 to 01.08.2012) or a number of times (e.g. beginning on 01.01.2012, clone the event every 3 weeks, 10 times).

- Clone on given days: This allows you to clone your event on given days. You will need to fix an interval (every $x$ months) and give a start/end date or a start date and the number of times you wish to clone the event (e.g.
beginning on 01.01.2012, every 2 months until 01.01.2013 or beginning on 01.01.2012, every 2 months, 10 times).

**Posters**

It is possible to create your own posters for the conference in Indico. You can either generate one of the pre-existing templates offered by your installation or generate event specific templates, either using the aforementioned ones as a basis or something entirely new.

**2.4. Conference Management Area**
As with Badge / Tablesigns, you are permitted to alter the resultant PDF options by clicking the ‘PDF Layout Options’ button and setting the parameters as required beforehand.

The list of event templates are templates which are only available for this event, you may freely edit, clone or delete these poster templates at will.

The Poster design page is very similar to the Badge / Tablesigns design page. The options are broken into two tabs:

- Template settings: Including dimensions, name.
- Element settings: When an element is selected, this pane is auto enabled and permits you to modify font styles and sizes and, if the element is a fixed text item, you can edit its value here. For the latter, double clicking the element directly will prompt you to change its value.
Badges/Tablesigns

From the list of participants, Indico automatically generates printable badges for each of them. You can customize them in this tab, and then print them.

As for posters, you have the option to create a new template or to upload an already existing one.

Lock

You can lock the event. If you do so, you will not be able to change its details anymore. Only the creator of the event or an administrator of the system/category can lock/unlock an event. You will be asked to confirm.
Delete the conference. There is no undo tool so far, but you will be asked to confirm deletion.

Material Package

Using the Material package option you can create a package of all the material that has been used in the conference.
**Create an Offline version of a Conference**

Within the *Offline version* tab you can generate an offline copy of your lecture. This is useful if you want to make it available where no Internet connection is available or to distribute it in external devices.

After clicking on *Generate*, your request will appear in the list along with its status. Once the generation has finished, you will be able to download the offline website from the same list.
2.4.15 Layout Management

The display area allows you to customize your conference. You can customize the menu that will be shown in the conference display (see Conference Display), change the colours of the conference background/text, add a logo and much more. It contains four tabs, that are explained below.
Layout customization

The display area allows you to customize your conference. You can customize the menu that will be shown in the conference display (see Conference Display), change the colours of the conference background/text, add a logo and much more.

- Stylesheets: CSS
- Color customization: You can change the background colour of the conference header by using the Conference header background color option in the Layout customization tab. The same can be done for the text colour by using the Conference header text colour option.

Color customization

| Conference header text color |  | Apply color |
| Conference header background color |  | Apply color |

- Logo customization: If you want to add your own logo to the conference display you can add it from the logo area in display. In the Layout customization tab, you can browse for your logo, save it, and see it in the preview box.

Conference logo

Upload a logo  

Preview  

remove

Conference header

This tab has two main parts:

- Announcement: You can enable and disable this option by clicking on the buttons Enable/Disable. Below this, you can type your announcement. This announcement will appear below the title and date of the conference in the event page, as you can see below

2.4. Conference Management Area
• Conference header features: you can choose what will appear in the header. To enable/disable an option, click on . When it is green, the option is enabled, when red, it is disabled.

Menu

This is where you can customize the menu that will appear in the event page. You can choose what options to display, add spacers or URL links.
• Add link: You can add any link you wish to appear in the event page. You can select if you wish the link to appear in a new or in the same window. In the example below, we have added a link to Indico. Clicking on it will open a new Indico page.
### Create external link

<table>
<thead>
<tr>
<th>Name</th>
<th>Indico</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td><a href="http://indico.cern.ch">http://indico.cern.ch</a></td>
</tr>
<tr>
<td>Display target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display in a NEW window</td>
</tr>
<tr>
<td></td>
<td>Display in the SAME window</td>
</tr>
</tbody>
</table>

[save] [cancel]
• Add page: You can add a new page in the event page. Click on Add page and you will be presented with the following form:
In the image below, the title of the page is circled in red, and the text typed in the text box is circled in green.
• Add spacer: You can add a spacer between two options in the even page menu. You first need to choose where to place it; while creating it, you need to click on the arrows move up/down the spacer. It will appear on the left menu with all the options (circled in red below):
Menu Display

Once you have created the spacer, the result will look as following in the event page:
Images

In this tab you can upload images. This will give you a link for the given image. When you need to make use of this image, copy and paste this link. Clicking on it will redirect you to the image.

To upload an image, click on and then on Browse. Once you have found the picture in your documents, click on Upload.

2.4. Conference Management Area

Dates: 25 July 2011 (08:00-18:00)
Timezone: Europe/Zurich
Location: CERN
2.4.16 Logs Management

The Event Log presents a summary of the most relevant actions performed on the whole of the conference along with filtering options for easily finding specific ones.

The list contains actions grouped by day and each row displays the type of a single action (icon), the module in which it was performed, a brief description, and the person who triggered it. By clicking a row extended information can be displayed.

The toolbar allows to filter by kind of action and the search box to filter by match with any of the relevant content. There are also two buttons for expanding and collapsing extended information of all rows.
2.5 Conference Display Area

The Conference Display is the view that users of the conference will see. If the conference is public they will not need to log in to view the conference. It is also the area from which you can access the modification areas if you have access rights. The different areas of the conference can be seen using the left-hand Display Menu. This menu may be different if the Conference Manager has customized it. When a conference is accessed the Overview area is shown first.

2.5.1 Navigating the Conference Display Area

Various parts of the conference display are always present in order for you to navigate or view the display area:

- ![Home icon](image) This is placed at the top left of the display view and will take you back to home page of Indico.

- ![More icon](image) This is also placed at the top left of the display view and allows you to use additional features (e.g. export the details of the conference in iCalendar format)

- ![Support icon](image) This will be underneath the display menu and enables you to email the event support if conference management have entered one.

- ![Login icon](image) This is placed at the top right of the screen and is the access for logging in or out.

2.5.2 Overview Area

The Overview Area shows the main details of the conference including any material that is included and the date and location of the conference.
2.5.3 Call for Abstracts Area

The Call for abstracts view will show the range of dates during which an abstract can be submitted.

From within the Call for abstracts a user can submit an abstract and view the abstracts they have submitted.

Submitting an Abstract

You need to be logged in as a user and the dates of submission must be in the time range to allow you to submit an abstract. Once logged in you can fill in the form to submit your abstract.
A rich text editor is provided to write an abstract. It supports LaTeX commands and Markdown syntax, an easy-to-write plain text format that is converted to valid HTML.

You need to fill in the title, content, and the mandatory fields specified (if any). You have to add/select at least one primary author. If you need to you can add any co-authors. It is possible to move authors and co-authors by doing drag and drop. Sometimes will be possible to attach files to the abstract, if the option has been set by the manager. You can also choose which track you would like your abstract to be included in as well as any comments you would like to add. You will receive an email notification after submitting.

Once everything is filled in click on submit to submit the form.
Viewing your abstracts

You can view and see the status of any abstracts you have submitted. You can also create a PDF of your abstracts. By clicking on the abstract name you will see the details of the abstract.

Abstract Display

When you click on an abstract’s title you will be taken to the abstracts view. This shows all the details of the abstract.
You can print the details of this abstract as a PDF using the link in the top right corner.

### 2.5.4 Author Index

The Author Index shows all the authors with contributions in the conference; the authors can be searched for by name.
The contribution(s) (see Contribution Display) they have written and the details of the author can be accessed by clicking on the name.

Author Display

The Author Display shows the details of the author, e.g., contact details and the contribution(s) he has authored.
2.5.5 Contribution Area

Contribution List in the menu takes you to all the contributions in the Conference. From here you can see a list of all or just certain types of contributions that you wish to see, e.g. only those contributions in a specific session. You can also filter by a pattern to find in the title or description of the contribution.

You can access the display of each contribution by clicking on its name. You can also create a PDF of either displayed contributions or all of them.

Contribution Display

In the Contribution Display you can see all the details of the contribution, including the description, the primary and co-authors, the session (if any) it is included, the track, the contribution type, any material (see Contribution Material Display) it has and any sub-contributions that belong to it. You can also access those details by clicking on their names. You can also print the contribution in PDF, XML, or iCal format by using the links in the top right-hand corner.
If you have modification rights, you will have the modification link next to the print formats and you can access the Contribution Modification Area.

**Contribution Material Display**

The material that belongs to a contribution can be viewed by accessing the Contribution Display (see Contribution Display). Here, there is a section *Material* with all the resources attached.

**Material**

- **Slides**
  - chep2009.pdf
  - chep2009.pptx

Having the proper access, by clicking in *Edit files* is possible manage the material attached. It will open a popup, and by clicking in *Add Material* is possible to upload more, in the edit icon to modify, and in the red cross to remove it.
2.5.6 My Conference Area

The *My conference* area gives you access to those areas for which you have co-ordinator or modification rights. For example, if you are a Track Co-ordinator or a Session Co-coordinator those tracks or sessions will appear under *My conference*. Same thing if you are submitter for a contribution.
More information here:

- Tracks Modification \(\text{(see Tracks)}\)
- Session Modification \(\text{(see My Conference: Session Co-ordination)}\).

### 2.5.7 Registration Area

The Registration Area shows you the dates in which you are able to register, the maximum number of registrants allowed and any contact information.

#### New Registrant

From the New Registrant Area people can fill in the forms that were chosen and customized from the Registration Management \(\text{(see Registration Management)}\). The registrant will need to fill in their personal information and anything else in the form that has been asked for.
Registration Form

Please, note that fields marked with * are mandatory

Personal data

Title
* First Name: Anna
* Surname: Roeo
Position
* Institution: Cern
Address
* City
* Country: Select a country
Phone
Fax
* Email: dkkidg@cern.ch
Personal homepage

Reason for participation

Please, let us know why you are interested in participate in our event:

Sessions

Select your preferred choice: * None selected
[Optional] Select your second choice: * None selected

Accommodation

* Arrival date: * Select a date
* Departure date: * Select a date

* Select your accommodation:
  CERN Hostel
  I prefer to book a room in a Geneva hotel
  I will arrange my own accommodation

Social Events

Select the social events you would like to attend and how many places you will need:

Further information

Content of Further information
Once your registration has been submitted you will be shown a screen to confirm your registration.

Thank you for completing the registration form which has been sent to the organisers for their attention. Please proceed to the payment of your order (by using the "Next" button down this page). You will then receive the payment details.

<table>
<thead>
<tr>
<th>Registrant ID</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>Perez</td>
</tr>
<tr>
<td>Surname</td>
<td>Manolo</td>
</tr>
<tr>
<td>Position</td>
<td></td>
</tr>
<tr>
<td>Institution</td>
<td>CERN</td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>Ourense</td>
</tr>
<tr>
<td>Country</td>
<td>ES</td>
</tr>
<tr>
<td>Phone</td>
<td></td>
</tr>
<tr>
<td>Fax</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:esemanolin@gmail.com">esemanolin@gmail.com</a></td>
</tr>
<tr>
<td>Registration date</td>
<td>21-January-2010 20:05</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Registration Fee</th>
<th>Both days: full price 445 CHF</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>dinner: no 45 CHF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
<th>Unit Price</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Registration Fee:Both days: full price</td>
<td>445.0</td>
<td>445.0 CHF</td>
</tr>
<tr>
<td></td>
<td>TOTAL</td>
<td></td>
<td>445.0 CHF</td>
</tr>
</tbody>
</table>

If the epayment is enabled. The user will be able to click the button next and proceed with the payment online.

The menu option which was New registration will also change to Modify my registration. This will present you with the form you filled in originally and will allow you to change the information you originally provided.

### 2.5.8 Book of Abstracts

The Book of Abstracts selection in the menu will produce a PDF document of all the accepted abstracts (abstracts that have become contributions) that are scheduled in the conference. It also shows any contributions that are scheduled.

### 2.5.9 Scientific Programme Area

The Scientific Programme shows all the tracks with their descriptions:
You can create a PDF document of all the tracks using the PDF icon in the top right-hand corner. If you are a Coordinator of any tracks, you will have the modification logo next to that track and a Manage my track option in the menu as in the picture above.

2.5.10 Timetable Area

You can access the conference’s timetable from the event page by clicking on the Timetable link. The Timetable area shows all the session, contributions, and breaks for the conference. You can access each session content by clicking on the session name. This will show you any contributions/breaks inside this session.

Clicking on a contribution will open a popup with the option “View details” that will take you to the display view of that contribution (see Contribution Display).

On the top right of the timetable, there are different options available to you:

- Print: Click here if you wish to print the timetable. You will be redirected to a preview of the printed timetable. If you wish to print, click on Print. Otherwise, click on Go back

2.5. Conference Display Area
• PDF: Get a PDF document of the timetable. Click on this and you will be presented with a form, where you can customize the document, by choosing Normal timetable/ Simplified timetable and their inner options (see below). You can also choose the PDF options, i.e. page/font size and the page numbering.

PDF timetable customization

**Normal timetable:**
- Print cover page
- Print Table of Contents
  - Show sessions in the Table Of Contents
- Print the ID of the contribution
- Print ABSTRACT CONTENT of ALL the contributions
  - Do NOT print the ABSTRACT CONTENT of poster sessions
- Show length of each contribution
- Print the TITLE of the speakers
- Print the affiliation of the speakers/conveners
- Print each session on a new page
- Use session color codes
- Print contributions which are not within any session
- Print 'breaks' which are not within any session
- Print the starting date close to sessions title

**Simplified timetable**
- Print contributions which are not within any session
- Print 'breaks' which are not within any session

PDF Options

<table>
<thead>
<tr>
<th>Page size</th>
<th>A4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font size</td>
<td>normal</td>
</tr>
<tr>
<td>Begin page numbers with number</td>
<td>1</td>
</tr>
</tbody>
</table>

Once you have chosen all your options, click on **get pdf**

• Full screen: Click on this to get a full screen view of the timetable. To exit, simply click on Go back on the top right of the page

• Detailed view: Clicking on this will show what happens inside the sessions, as opposed to just the sessions. For example, if a session has an inner timetable, clicking on Detailed view will display it.

In this conference, this is the normal view:
And this is the detailed view:

### 09:00

- **Optimisation of LHC beam conditions**
- **W/Z production at HERA**
- **Extraction of Compton Form Factor...**
- **Jet-medium interactions in heavy ion collisions**
- **Studies of polarized ep collisions at...**
- **On chiral-odd Generalized ...**
- **Quarkonium production at the Tevat...**
- **Double quarkonium production at the LHC**
- **Jet reconstruction in heavy ion...**
- **Scattering amplitudes in maximall...**
- **Detemination of the Luminosity by the LHC Experiments**

### 10:00

- **Performance of the CMS Hi...**
- **LHCb trigger system**
- **W and Z boson production a...**
- **Measurement of W and Z b...**
- **Deeply Virtual Exclusive Re...**
- **Measurement of J/psi, Upsi...**
- **Deeply Virtual Compton Sc...**
- **Study of Jpsi production a...**
- **Medium Modification of Vector ...**
- **Initial-state-radiation pro...**
- **Performance...**
- **Monodromies and the struct...**
- **RAK, JAN First glance...**
- **Phase diagram of hot QCD in a...**

In this detailed view, you can click on the icon to get all the material belonging to the contribution.

If you click on the contribution, a balloon will appear. Click on View details to access the contribution’s page. You can export this contribution by clicking on Export in the balloon. You can export it as a PDF, calendar or XML file.

- **Filter:** You can filter the information displayed in the timetable. For example, you can choose to display only certain sessions, or sort the timetable by rooms (only display events happening in certain rooms).
- **Tabs:** You can choose to view all the events in one specific day, or view all days on the same page. To view a single day, click on its corresponding tab. To view all days, click on the tab All days.

### Session View

Session View allows you to see any contributions or breaks within each session:
If you are a Session Co-ordinator or a Session Manager you will have the modification icon in the top right-hand corner as above. This will take you to the appropriate Modification area for that session. You may also make a PDF of the session.
3.1 Meeting

A Meeting is not as in depth as a Conference and is made for smaller events. Within a Meeting you can find the modules:

- General settings: Where you can manage the general settings of the meeting (e.g. title, location etc.)
- Timetable: In which you can directly add Sessions, Contributions, and Breaks.
- Material: Where you can upload material that will be attached to the meeting. The material can be slides, videos, minutes etc.
- Participants: you can add all the participants for the Meeting or you can open the participation so users can apply for it.
- Evaluation: You can submit an evaluation form to be completed by the participants. You can set the questions, edit the form and the results and preview it in the different tabs available
- Lists: Relevant lists of users, such as list of all sessions’ conveners etc
- Protection: Set the access control for the meeting
- Tools: Where you can set alarms, clone the conference etc.
- Logs: List of all the actions performed on the whole of the meeting

3.2 Creating a Meeting

To create a meeting, click on Create -> Meeting in the top blue menu bar. You will be presented with a form you need to complete. First, you need to choose the category in which your meeting will be created. Then, enter the basic information (title, start/end date etc.); you can choose the default style in which the Meeting will be displayed (see Meeting Display Area). Finally, set the access protection. Click on Create meeting. You will be redirected to the meeting’s Management Area.
3.3 Meeting Management Area

The Management Area allows you to control the different parts of your meeting. The following sections will show each option of the Meeting Management Area.

Clicking on the link Switch to event page will take you to the event page of the meeting.

3.3.1 General Settings Management

In General Settings, you can edit the title, description, place, start/end date, timezone, default style, event type. You can add a support e-mail and modify its caption; it will be displayed in the event page. It is also possible to create a short display URL, used as a shortcut to the event page. You have the possibility of changing the default style, (see Meeting Display Area). To edit the visibility, see visibility in General Settings for conferences. Finally, you can add or remove any chairpersons.

3.3.2 Timetable Management

The Timetable Management allows you to organize your meeting by using sessions (groups of contributions), contributions (presentations), and breaks.

The management of the timetable is the same as for conferences. The only difference is while adding contributions. In conferences, you can add unscheduled contributions to the timetable. In meetings, unscheduled contributions don’t exist, therefore you will always need to create the contribution.
Here, we will just explain how to create contributions. For more details and further explanations about the Timetable Management see Timetable Management for Conferences.

### Adding Contributions

You can directly add contributions into your timetable using the *Add new > Contribution* at the top of the timetable. This will open a pop-up with a form to create a new contribution.

Within this form, you can define the name, description, location, presenters, the starting time and duration of this contribution.
In order to edit the contribution, you can click on it and an edition balloon will show up. In this balloon, you can modify the timing or the whole contribution.

**Session Management**

See Session Management for Conferences.

**Contribution Management**

See Contribution Management for Conferences.

### 3.3.3 Material

Here, you can upload any material you wish to attach to the meeting. The material can be video, slides, minutes etc. You can modify the material by clicking on 📄 or to delete it by clicking on ✖️.
3.3.4 Chat rooms

Similar to lectures; see Chat room for lectures.

3.3.5 Video Services

Similar to lectures; see Video Services for lectures.

3.3.6 Participants

You can access the participation module from the option Participants in the menu on the left.

The module is divided in different tabs (more detailed in the following subsections):

- Setup: configuration of the participation module.
- Participants: it shows the list of participants. Managers can perform several actions on the list, such as adding new participants, removing, inviting, etc.
- Statistics: it shows the number of participants that have attended, declined participation, pending, etc.
- Pending: list of all the users that have applied for participation and awaiting the approval or refusal.
- Declined: list of the participants that have been declined for the event.

Setup

In this tab you can setup the participation module. The options that you can enable/disable by clicking in the red/green squares are the listed below.

- If a participant is added by the event managers, an email notification will be sent to him.
- Show the list of participants in the event page-
- Allow the users to participate in this event by showing a link in the event page.
- Approve the participation request by the event managers.
- Activate notification by email when a new participant applies with no need to be approved.
- Setup the maximum numbers of participants where 0 means unlimited.
Participant list

In this tab, one can view the list of all the participants. You can add or remove participants (as a manager), mark as present/absent, ask for excuse, send email etc. You can also export the list of participants to Excel by clicking on the Excel icon on the button bar.

The event manager can add participants in the two following ways:

Manager adds participants

In order to add participants, click on

- Add >*Indico User* if the participant or the e-group exists in Indico database;
- Otherwise, click on Add->New user.
Manager invites participants

To do so, click on \textit{Add > Invite}. The participant(s) invited will receive an email informing them they have been invited to an event. This email will contain a link they will have to use to accept/reject the invitation.

\begin{verbatim}
Content-Type: text/plain; charset="utf-8"
From: anamaria.costache@cern.ch
To: anamaria.costache@cern.ch
Subject: Invitation to Meeting 2

Dear Anamaria Costache,

\textbf{Event manager}, event manager of 'Meeting 2' would like to invite you to take part in this event, which will take place on 2011-07-30 08:00:00+02:00 in CERN. Further information on this event are available at http://indicodev2.cern.ch/conferenceDisplay.py?confId=137363
You are kindly requested to accept or decline your participation in this event by clicking on the link below:
http://indicodev2.cern.ch/confModifParticipants.py/invitation?participantId=1&confId=137363

Looking forward to meeting you at Meeting 2
Your Indico on behalf of Event manager

When they will open the link, the following window will appear:

\begin{center}
\includegraphics[width=\textwidth]{image}
\end{center}

They will then need to click on \textit{Accept} or \textit{Reject}.

Pending list

As explained in \textit{Setup} you can setup the approval to be made by the event managers.

Users will be able to apply from the event page, by clicking on \textit{Apply here}.
A window will appear:

To apply, you will need to click on *Ok*

If the manager chooses to approve the requests for participation, he will see the tab *Pending* highlighted:

To accept or reject a request, he will need to click on the tab and the following window will appear, where he can manage the requests. When you reject an application you can choose whether to send an email or not.
Declined list

This tab shows the list of the participants that applied for participation and their applications were declined.

3.3.7 Evaluation

Same as for lectures; see Evaluation.

3.3.8 Lists

See lists_management for Conferences.

3.3.9 Logs

See Logs Management for Conferences.
3.3.10 Protection Management

Protection in a meeting is the same as in a Conference. There is Modification Control, Domain Control, and Access Control. When adding to the Access and Modification lists, you can also add Groups of users if any have been defined by Administration.

Modification Control Only the managers listed in the modification control, the creator of the meeting, and any administrators can access the Management Area of the meeting. However, you can add a Modification Key which means anyone with this key can modify the meeting without logging in.

Access Control When the meeting is public, anyone can view the meeting including the details, timetable, material, etc. When the meeting is private, only those in the access list, meeting managers, and administrators can view the meeting. When it is inheriting, its access protection will be the same as its parent category. Changing the access protection of the parent category will change the access protection of the meeting (see Access Control Policy).

If the meeting is PUBLIC and has some element that is RESTRICTED, there will show a message ‘Some parts of it are, however, protected. Which ones?’ If you click in ‘Which ones?’ it will show a popup with the children protected. The same works when the meeting access is RESTRICTED and has PUBLIC elements.
If the meeting access is RESTRICTED the event manager will be able to set a ‘Contact in case of no access’, so users with no access will know who to contact in order to request access.

Also, when private you can also add an Access Key which means anyone with this key can access the meeting without logging in.

*Domain Control* This is available for public meetings. It allows you to specify which domain can access the meeting. For instance, choosing CERN will mean the meeting is only accessible for people inside the CERN domain.

*Material Visibility* By default a material will always be visible in the timetable, even if it is private (the user will be redirected to a login screen or access key prompt when clicking on it). You can force the material to be hidden for non-authorized people by using the *Visibility to unauthorized users* section in the material access control page.

### 3.3.11 Tools Tab

The meeting Tools allow you to make certain actions on the whole of the meeting. See following sub-sections.

**Alarm Control**

You can set an alarm/reminder in the same way as it’s done for conferences; see *Alarm Control*.

**Cloning a Meeting**

Clone the meeting if you would like to make another meeting exactly the same. You have the option to clone it once, at fixed intervals, or on certain dates. For more on cloning, see *Clone event* for conferences.
You have the possibility of creating posters for your meetings. You can create your own, or create one from a template.
Lock

It is possible to lock the meeting. If you lock the event, you won’t be able to change its details anymore. Only the creator of the meetings or an administrator of the system/category can unlock an event. You will be asked to confirm.
Deleting a Meeting

The Delete meeting option will delete the whole meeting. You will be asked to confirm deletion beforehand.

Confirmation Required

Are you sure that you want to delete the conference?

Test Meeting

Note that if you delete the conference, all the items below it will also be deleted

Yes, I am sure  No
Packaging Material

Using the Material package option you can create a package of all the materials that have been used in the meeting.

Create an Offline version of a Meeting

You can create an offline copy of a meeting in the same way it’s done for conferences; see Create an Offline version of a Conference.
3.4 Meeting Display Area

The Meeting Display is the view that users of the meeting will see. If the meeting is public they will not need to log in to view it. It is also the area in which you can access the modification areas if you have access rights. There are various views/styles in which the meeting can be displayed; the following sections show the different views and displays.

3.4.1 Indico Style

This is the default view for meetings in Indico. If you have modification rights to any parts of the meeting you will be able to access the Management Area by clicking the icon.

![Indico developers review meeting](image)

You can see a bunch of additional buttons next to the navigation options on the top left of the page:

- ![Print](image) This will print a printable version of the display area
- ![Filter](image) This will let you set filters to focus on events depending on their date or the session they are included in.
- ![iCal export](image) Opens the popup with all the options to export the agenda to your calendar.
- ![More](image) This button allows you to use the following additional features:
  - Export to PDF format
  - Download a package with all the material linked to the meeting
  - Change the style of the display. The following sections give you some examples of available styles.
The other icons are:

-  
  Gets you back to the Indico homepage
-  
  Brings you to the oldest event in the category your event belongs to
-  
  Brings you to the previous event in the category your event belongs to
-  
  Brings you to the category event overview your event belongs to
-  
  Brings you to the next event in the category your event belongs to
-  
  Brings you to the newest event in the category your event belongs to

From Manage, you can:

- Edit event: this will lead you to the management area of the meeting, same as for PENCIL
- Clone event: Leads you to the tab Clone Event in the Tools option; see Cloning a Meeting
- Edit minutes: add and edit your minutes. When you add minutes, the following appears in the event page:
  
  Clicking on Minutes on the left will open the minutes in the same page; clicking on the icon on the right will open the minutes in a new tab
- Manage material: opens a window where you can add, edit or delete existing material

### 3.4.2 Simple Text Style

The simple text style:

```
Meeting 1 [Friday 19 February 2010]

08:00  Contribution 1
  o Sub Contribution 1

Session 1
-----------------------
09:20  Contribution 2
  o Sub Contribution 2
```
3.4.3 Administrative Style

The Administrative style:

You can pass extra parameters to this compact style in order to choose the amount of days to display in one row and the start and end date. The parameters are:

- `daysPerRow`: number of days that you want to show per row (as a table row).
- `firstDay`: first day to be shown (must have the format 1-January-2010)
- `lastDay`: last day to be shown (must have the format 3-January-2010)

Let’s suppose you have a 2 weeks meeting:

http://indico.cern.ch/conferenceDisplay.py?confId=XXXX&view=nicecompact (where XXXX is the ID of your meeting)

and you want to display in the 1st row the 1st week and just underneath the second week, you can do it adding the extra parameter `daysPerRow` as follows:

http://indico.cern.ch/conferenceDisplay.py?confId=XXXX&view=nicecompact&daysPerRow=7 (where XXXX is the ID of your meeting)

3.4.4 Compact Style

The Compact style:

You can pass extra parameters to this compact style in order to choose the amount of days to display in one row and the start and end date. The parameters are:

- `daysPerRow`: number of days that you want to show per row (as a table row).
- `firstDay`: first day to be shown (must have the format 1-January-2010)
- `lastDay`: last day to be shown (must have the format 3-January-2010)
3.4.5 Parallel Style

The Parallel style:

<table>
<thead>
<tr>
<th>08:00</th>
<th>Contribution 1</th>
<th>09:00 - 09:20</th>
</tr>
</thead>
<tbody>
<tr>
<td>09:00</td>
<td>Session 1</td>
<td>09:20 - 09:20</td>
</tr>
</tbody>
</table>

10:00
4.1 Lecture

A Lecture is the simplest form of event within Indico. The following modules can be found in a lecture:

- General settings: Set the general settings of the conference
- Material: Attach material to the lecture (slides, videos etc.)
- Participants: You can add all the participants for the Meeting or you can open the participation so users can apply for it
- Evaluation: You can set an evaluation form to be completed by the participants
- Protection: Set the access protection of the lecture
- Tools: Where you can set alarms, lock/delete/clone the lecture, etc.
- Logs: List of all the actions performed on the whole of the lecture

4.2 Creating a Lecture

If you have the correct access rights within a category, you can create a new lecture by clicking on Create event then Lecture from the blue top bar. You will be presented with a form similar to that for a Meeting. You will need to choose a category in which to create your lectures, then the basic information; you can choose the default style in which the Lecture will be displayed (See Lecture Display Area). Set the access protection and click on Create lecture; you are done. You will be redirected to the Lecture Management Area.

4.3 Lecture Management Area

The Management Area allows you to control the different parts of your lecture. The following sections will show all the options in the Lecture Management Area.
4.3.1 General Settings Management

In General settings, you can: edit the title, place, start/end date, timezone, default style (see Lecture Display Area), visibility (see General Settings for conferences), event type, keywords. You can add a description to your lecture, a support email and its caption (which will appear on the event page), organizers and a short display URL (used as a shortcut to the lecture's event page). You can also add or remove speakers.

Clicking on the button Switch to event page will take you to the home page of your event.

4.3.2 Material

You can add material to the lecture, by using the Material menu, and the link Add Material. You can then enter the name and description of the material.
The material can be files or links. You also protect the material to control who has access to view it.

### 4.3.3 Chat room

If the Indico administrators have enabled the chat room module, you can create chat rooms for your lecture. For more information, see chat_guide.

![Chat room creation](image)

### 4.3.4 Video Services

If the Indico administrators have enabled the Video Services functionality, you can have access to the Video Services option. The tabs in Video Services are:

- **Videoconferencing**: Set up a videoconference
- **Recording request**: Once you’ve set up the location of the lecture, you can do a recording request. You will be presented to a form to complete and you will need to ensure that all speakers have given their permission to have their talks recorded.
- **Webcast request**: You can do a webcast request. You need to complete a form, select a room capable of webcasting and ensure that all speakers give their permission to have their talks webcasted
- **Managers**: Here you add video services managers and managers for individual systems

For more information, see video_guide.
4.3.5 Participants

You can view here a list of all the participants. One can add or remove participants (as a manager), mark as present/absent, ask for excuse, send email, export the list of participants to Excel, among other options.

For more info see Meeting participants.

4.3.6 Evaluation

You can set an evaluation form to be completed by the participants. There are four tabs in this option:

- Setup: Where you set the basic details, such as evaluation start/end date, max. number of submissions etc. You enable and disable the form by clicking on Show/Hide. You also have special actions, such as export or import the evaluation etc.
- Edit: This is where you create the evaluation form. You can add a textbox, textarea, password, select, radio or checkbox question.
- Preview: This shows you a preview of your evaluation form. Feel free to try it, any form submitted from here will not be taken into account.
- Results: Results of the evaluation

For more on the evaluation process, go to Event Evaluation
4.3.7 Protection Management

Protection Management in a lecture is the same as that in a Meeting. There is Modification Control, Domain Control and Access Control. When adding to the Access and Modification lists, you can also add Groups of users if any have been defined by Administration.

**Modification Control** Only the managers listed in the modification control, the creator of the lecture, and any administrators can access the Management Area of the lecture. However, you can add a Modification Key which means anyone with this key can modify the lecture without logging in.

**Access Control** When the lecture is public, anyone can view the lecture. When the lecture is private, only those in the access list, lecture managers, and administrators can view the lecture. When it is inheriting, it has the same access protection as its parent category. Changing the access protection of its parent category will change the access protection of the lecture.

If the lecture access is PRIVATE the event manager will be able to set a ‘Contact in case of no access’, so users with no access will know who to contact in order to request access.

Also when private you can also add an Access Key which means anyone with this key can access the lecture without logging in.

If the lecture is PUBLIC and has some element that is RESTRICTED, there will show a message ‘Some parts of it are, however, protected. Which ones?’ If you click in ‘Which ones?’ it will show a popup with the children protected. The same works when the lecture access is RESTRICTED and has PUBLIC elements.
Domain Control

This is available when the lecture is public. You can specify which domain can access the lecture. For instance, choosing CERN as a domain means only users accessing from a computer in the CERN domain will be able to access.

4.3.8 Tools Management

The lecture Tools allow you to carry out certain actions on the whole of the lecture.

Alarm Control

You can set an alarm/reminder in the same way as it’s done for conferences; see Alarm Control.

Cloning a Lecture

Clone the lecture if you would like to make another lecture exactly the same. You have the option to clone it once, at fixed intervals, or on certain dates.
Clone the event: Test Conference

Step 1: What to clone?

Choose elements to clone:
- Main information
- Attached materials
- Access and management privileges
- Alerts
- Participants
- Evaluation
- Chat Rooms

Step 2: When to clone?

You have the possibility to: clone the event once, clone it using a specific interval or specific days.

Clone the event only once at the specified date

07/02/2014

Clone the event with a fixed interval:

- every: 1 week(s)
- starting: 07/02/2014
- until: 07/02/2014 (inclusive)
- 1 time(s)

Clone the agenda on given days:

- on the: 1st, Monday
- every: 1 month(s)
- starting: 07/02/2014
- until: 07/02/2014 (inclusive)
- 1 time(s)

For more explanation on the cloning process, see Clone event for conferences.
As for meetings, you can create posters for your lecture. You can either create your own, or use a local template.

Lock

It is possible to lock the lecture. If you lock the event, you won’t be able to change its details anymore. Only the creator of the lecture or an administrator of the system/category can unlock an event. You will be asked to confirm.
Deletion Request

Confirmation Required

Are you sure that you want to lock the event?

Test Conference

Note that if you lock the event, you will not be able to change its details any more. Only the creator of the event or an administrator of the system / category can unlock an event.

Yes, lock this event  No

Deleting a Lecture

The Delete option will delete the whole lecture. There is no undo tool so far, but you will be asked to confirm deletion beforehand.
Material Package

Using the Material Package option you can create a package of all the materials that have been used in the lecture.
Create an Offline version of a Lecture

You can create an offline copy of a lecture in the same way it’s done for conferences; see *Create an Offline version of a Conference*.

4.4 Lecture Display Area

The Lecture Display is the view that users of the lecture will see. If the lecture is public they will not need to log in to view the lecture. It is also the area in which you can access the modification areas if you have access rights. There are various views in which the lecture can be displayed; the following sections show the different views and displays of the different parts of a lecture.
4.4.1 Lecture Style

This is the default view for lectures in Indico. If you have modification rights to any parts in the lecture, you will be able to access the Management Area by clicking the modification icon. You can also do some management actions from the tab Manage on the right of the title.

4.4.2 IT Style

The IT style:
4.4.3 CDS Agenda Style

The CDS Agenda style:

![CDS Agenda Style](image)

4.4.4 Static Style

The Static style:

![Static Style](image)

4.4.5 Simple XML Style

The Simple XML style:

![Simple XML Style](image)
4.4.6 Event Style

The Event style:
CHAPTER
FIVE

USERS AND GROUPS

5.1 Users

Recognised users are Indico users or users belonging to an external database.

When searching for an Indico user, filling any of the criteria and then clicking on the button Search will do.

If you are looking for someone and not finding that person, he or she might not have an Indico account. In that case, you may want to tick the checkbox option to search for users in an external database (e.g. at CERN you will see something like Search CERN user database). Moreover, clicking on at the right of the name will add the person to your favourites, which means you won’t have to search for them next time; they will appear at the right of the search box instead, in the Suggested users area.
5.2 Groups

In Indico, groups work similarly to users.

Recognised groups are Indico groups, or groups belonging to an external database. The searching criteria described above applies to groups; if you are not finding a group, you may want to tick the option to search in an external database.
5.2. Groups
6.1 To Personal Scheduler Tools (Outlook, iCal, korganizer...)

You can export an event or a set of events to your personal scheduler tool by using the Indico iCal export. There are different ways you can export data into iCal:

- With the icon which you can find when looking at a category’s events. This will export the whole event into iCal:

- From the event page, from the menu More -> Export to iCal. You have the choice to export the event or the timetable. Clicking on Export event will export the event into iCal and clicking on Export timetable will export the timetable, with all the contributions etc. within it.
• From the category’s overview page, by clicking on the link *iCal export*, on the top right. This will export all the events in the given category.

On a category page, all events in the category will be exported. Some scheduler tools recognize multiple events (iCal, korganizer, Outlook 2007), others do not (Outlook 2003); in this case, only the first event in the list is recognized.

You can also ask your personal scheduler tool to subscribe to one of these export URLs (this is particularly interesting for the Category export). For iCal: “Calendar” menu -> menu item “Subscribe”, then enter the URL of the iCal export. Finally, set the “Refresh” to “Every day”. Every day, your iCal software will update its content with any new event in the Category.

### 6.2 RSS feeds

Indico provides RSS feeds on each Category page. If your browser is RSS-aware, you will see an icon like this on the browser menu bar: 📱. Click on it to access the RSS feed, and subscribe to it using an RSS aggregator.
6.3 Sharepoint

If you maintain a Sharepoint web site, it is very easy to create inside it a web part exposing the forthcoming events from an Indico category. First add an XML web part, then in the “XML link” part, add the URL from indico (e.g. http://indico.cern.ch/export/categ/2112.json?from=today&to=tomorrow, see Using the HTTP Export API) and in the “XSL link” part, add this URL:

http://indico.cern.ch/export.xsl

The result should look like this:

<table>
<thead>
<tr>
<th>Coming UDS meetings</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2007-05-02</td>
<td>14:00</td>
<td>AVC section meeting</td>
</tr>
<tr>
<td>2007-05-09</td>
<td>14:00</td>
<td>AVC section meeting</td>
</tr>
<tr>
<td>2007-05-21</td>
<td>10:30</td>
<td>IT-UDS Group Meeting</td>
</tr>
</tbody>
</table>

6.4 Using the HTTP Export API

Indico has an export API which allows you to export categories, events, rooms and room bookings in various formats such as JSON, XML, iCal and Atom. For details no how to use this API, you can access the HTTP API documentation.
7.1 Introduction

This chapter describes the Indico module for booking conference rooms.

Indico users can book conference rooms for their conference and meeting purposes. Bookings can also be standalone - they do not have to be bound to any event. Room managers can monitor and moderate all bookings. Indico administrators can create rooms and manage their data.

Instead of being a boring manual no one ever reads, this file is an introduction, and it assumes you have some intuition of how the web works. The suggested way of learning is to start with a tutorial, then play with the module on your own. Simply use the software as any other Web page. Read context help along the way. Finally, come back for some tips.

7.2 The Tutorial

You can read the Core Features listings in order to get a full overview of the options of the room booking modules. It allows you to assign a room to a particular event, a talk or simply to book a room on its own, without attaching it to a event. The booking can then be managed from the administration area.
7.2.1 Getting into Room Booking Module

To use Indico::CRBS directly, just click on Room Booking in the Indico home page, in the top blue bar. To book rooms for your event, go to the event management page and click on the Room Booking option. In both cases you will be asked to sign in. Use your Indico login.

7.2.2 The First Page

The Room Booking Module first page depends on who is logged in. For most people, it will show a list of their bookings. The My bookings menu option will give you the same list. Room managers will see bookings of rooms they manage, so they can have a quick overview. If you are a room manager, use the Bookings option in My rooms menu to show the page again (this is only available for room manangers).

7.2.3 The Most Important Tip

If you require it, point at the question mark icon with your mouse to see context help. Context help is meant to answer most of your questions along the way.

7.2.4 Room Names

If a room does not have a name, the default name is built in the following way:
“location: building-floor-room”


![Image of Room Booking Module](image)
7.2.5 Three Kinds of Room

There are three kinds of room. They determine how much freedom users have.

- **Public rooms** which do not require confirmation (black/green colour). This means all bookings are accepted.

- **Public rooms** which do require confirmation (orange colour). You can PRE-book them and wait for acceptance or rejection.

- **Private rooms** which cannot be booked at all (red colour). Only the room manager can book his/her private room. If you need such a room, you should ask this person to create a booking for you.

7.2.6 Six Types of Booking

There are six types of booking. They allow you to define different types of recurring reservation. A common example is a weekly meeting (which takes place at the same time every week). You can choose from:

- **Single day**: not recurring, one-time event
• *Repeat daily*: use if you want to book many subsequent days, like an entire week
• *Repeat once a week*: the booking will take place every week, always on the same day
• *Repeat once every two weeks*: as above, but repeats every two weeks
• *Repeat once every three weeks*: as above, but repeats every three weeks
• *Repeat every month*: allows you to do bookings like ‘first Friday of each month’, ‘second Wednesday of each month’, ‘fourth Saturday of each month’, etc.

### 7.2.7 Booking a Room

On the Indico main page, click the *Room Booking* menu option. This is how you access the Room Booking Module. From there, click the *Book a Room* menu option.

The booking process consists essentially on three steps:

• Specifying the search criteria
• Selecting an available period
• Confirming the reservation
In the first step you can specify the rooms, date range and time range in which you want to search for bookings.

- The *room picker* allows you to filter by name, technical requirements, and minimum capacity. By clicking on a room you will mark it as a candidate for the booking.

- The *date range* selector allows you to specify the frequency and flexibility of the booking. Frequency allows to book the room a single time, daily, weekly or monthly. Flexibility extends the search a few days before and after the specified date.
• The time range simply serves the purpose of specifying the hours in which the room will be needed.

When you are done, click the button Search to proceed to the next step.

In the second step, you will be presented with a calendar summarizing the rooms, dates and times you specified previously. In this view you can check all available periods (marked in green), other bookings (in yellow) or conflicts (in red).

This view is very versatile. Give it a try: set the frequency of the search to to Weekly, set the end date to be at least 2 months after the start date, and search again. See the room calendar in its full glory.

If you click on an available period with you will be redirected to the next step in which you will confirm the reservation.
In the third and final step, you will need to complete the booking form. Click Book to confirm the reservation.

If your booking conflicts with others, you have two options:

- In general, it is better to resolve conflicts manually: by changing dates, hours or maybe trying another room.
- The alternative is to automatically book everything except conflicting days. This may be useful if you do long-term, recurring booking, for example, whole year, every week. Imagine everything looks perfect, except for several weeks when the room is not available. In this case check the ‘skip conflicting dates’ option to book everything except problematic dates.

If your form is correctly filled, the system will ensure your new booking does not conflict with others. When no conflicts are found, you will be shown the confirmation page which lists the details of your booking.

- Click My bookings from the menu. Your new booking now appears on the list.

Note: some rooms require confirmation. These rooms are usually coded in orange. In this case, you cannot directly book them. You can only PRE-book such a room. PRE-booking works exactly the same way as booking. The only difference is that you must wait for acceptance from the room manager.

Note: you can always modify your booking (or PRE-booking). It will again be checked for conflicts.
Note: you can always browse your own bookings and PRE-bookings using the menu options *My bookings* and *My PRE-bookings*.

### 7.2.8 View your Booking

You can view the bookings or pre-bookings that you made by going under the ‘My bookings’ and ‘My PRE-bookings’ sections of the Room Booking side menu. By selecting one of the bookings in the list, you will get the following:

This page contains all the information about a booking, and it allows you to modify, clone or cancel the booking. If the reservation is done for more than a single day, each of the occurrences of the booking can be canceled individually.

In addition, this page lets you watch the history of the booking (i.e. all the past actions that were performed on this reservation) if you are the creator of the booking. Only the most recent entry is partially displayed, but you can see the rest of it by clicking on the *Show All History...* link. Additional information about a particular entry can be viewed by clicking the *More Info* link.

### 7.2.9 Blocking a Room

As a room manager you may create room blockings which prevent regular users from booking certain rooms. This feature can be used for special events during which only a few people should be allowed to create bookings for some rooms.

To create such a blocking, go to ‘Block rooms’ in the Room Booking side menu and follow these steps:

- Choose the period during which the rooms should be blocked by clicking the start and end date on the calendars.
- Enter a reason for the blocking - it will be displayed to users trying to book one of the blocked rooms.
- Add some rooms to the ‘Rooms’ list. Those will be affected by the blocking.
- Unless you want to be the only one to be able to book the blocked rooms, you can add other users or groupe to the “Allowed users/groups” list.
- Submit the blocking after confirming that the chosen period is correct. Once you have created the blocking, the dates cannot be changed.
When trying to book a blocked room, users in the ‘Allowed users/groups’ list will see that the room is blocked and
the reason why but will be able to create bookings anyway. You as the creator of the blocking will always be able to
override your blocking, so you don’t have to add yourself to the list. The same applies to the owners of blocked rooms.
They will see the blocking and a warning that the room has been blocked, but they are able to override the blocking.

You can also create blockings for rooms you don’t own. These blockings will have to be approved by the respective
owners - until they do so, other users trying to create a booking on that room will see the pending blocking request but
will be able to carry on with their booking.

As soon as the blocking for a room has been approved (blockings for your own rooms are immediately approved when
creating the blocking), all bookings colliding with the blocking are automatically rejected.

7.3 Core Features and Constraints

7.3.1 Introduction

This section describes core capabilities and constraints of the Room Booking Module. It may be useful to assess
whether it meets your needs.

Note that the Room Booking Module is NOT supposed to be a general-purpose “room management” or “room book-
ing” software.

It was built with conference rooms in mind. Its main purpose is to make conference organization easier. We see room
booking as a part of conference organization (but it is possible to book rooms without associating the booking to an
event).

7.3.2 Core Features

General

General features are:

- Stand-alone and “in-conference” mode.
  - The stand-alone mode allows you to book, manage bookings and do administration stuff. You don’t have
to create an Indico event (the bookings will not be assigned to any Indico event).
  - The “In-conference” mode allows you to book rooms for your event. You can assign booked rooms to
conferences, lectures, meetings, sessions, contributions or breaks.

- Recurring bookings (‘every day’, ‘every week’, ‘every 3rd Wednesday of a month’, etc).

- E-mail notifications (to users and room managers, about every important action).

- Three user roles: (1) Indico administrator, (2) room manager and (3) ordinary user.

- Optional booking moderation. Each room may work in one of the following modes:
  - Bookings require explicit confirmation of room manager, \textit{or}
  - Bookings are automatically accepted.
User

Options available to regular users:

- Book a room
- Manage own bookings (track, modify, cancel)
- Search for rooms
- Search for bookings (including archival)
- View existing room blockings

Room Manager

In addition to what a user has access to, a room manager can:

- Accept and reject PRE-bookings (for his room(s))
- Reject bookings (for his room(s))
- Block rooms from being booked (with confirmation from the room owner)
- Accept blocking requests (for his room(s))

Indico Administrator

In addition to what a room manager has access to, an Indico Administrator can:

- Switch on/off Room Booking Module
- Configure room booking plugins in admin section
- Add/remove location
- Define room attributes specific to the location
- Define possible room equipment specific to the location
- Manage meeting rooms (add/modify/remove)

7.3.3 Constraints

The room must have its manager. It is not possible to define multiple managers for a single room (you can work around this by creating an Indico account shared by several people).

The room must have a defined building, which must be a number. This is mandatory. If you do not need building, put any number there (like ‘0’). If your building naming scheme has letters, we are sorry - the software is not flexible enough for you.

The room must have defined floor (alphanumerical) and room ‘number’ (alphanumerical in fact).
7.4 Dictionary

*Room*: meeting or conference room. Please note that the software is not suitable for managing other rooms, like offices, corridors, etc.

*Location*: physical location of rooms. Room custom attributes and possible equipment are defined on a location basis. Example: rooms at CERN may have different attributes and different equipment than rooms in Fermilab.

*Booking*: final reservation of a room. While considered final, it still may be rejected in case of emergency.

*PRE-booking*: unconfirmed reservation of a room. PRE-booking is subject to acceptance or rejection.

*Room responsible/manager*: the person who accepts/rejects bookings. Each room has exactly one person responsible. A person may be responsible for any number of rooms.

*Room blocking*: a restriction created by a room manager which prevents users from booking the rooms listed in the blocking unless they have explicit permission to override the permission or own the rooms.
CHAPTER
EIGHT

EVENT EVALUATION

8.1 Introduction

With this evaluation module for Indico you can create your own online web survey in order to know participants’ opinion about the conferences/seminars/lectures.

8.2 Functional goals

8.2.1 Security

Survey questions and statistical results are neither vital nor confidential for CERN members. We believe standard precautions are enough within this application. A survey will inherit access and modification rights from the event it belongs to. In other words, only users who are allowed to see an event will be able to have access to and fill in the evaluation form. The survey can only be altered in the Management Area. This means that only users who are already allowed to edit an event can create a survey, modify it and view the statistical results.

8.2.2 Usability

The main possible actions for the surveyor (management area) are the following:

- Create/edit an evaluation form concerning an event.
- Edit its options and status (visible/hidden).
- Possibility of setting that only logged users have access to the form.
- Create/edit questions contained in this form.
- Ability to preview a form while editing it.
- Import/export an evaluation in order to back it up or facilitate further creations.
- See the statistics of the results.
- Export statistics to a CSV file.
- Possibility of seeing/deleting individual answers in the results.
- Ability to send the evaluation link automatically by email to the participants at the start.
• Possibility of editing a survey in process even if some people have already answered it.

For a **submitter** *(display area)*:

• Access to the survey via the menu of an event.
• Logged users can always modify their already submitted forms.

### 8.3 Interface

#### 8.3.1 Management Area

In the *Evaluation* option we have four tabs: *Setup* | *Edit* | *Preview* | *Results*.

**Setup**

In this section you can set the main information and configuration about the survey. Click on **modify** to set your options.

- **Current status**: When an evaluation is HIDDEN (default), it is not shown in the Display Area and guests cannot answer it. You can show the evaluation by setting it to VISIBLE. But be aware that if you want your survey to work properly it must be open and contain some questions. To show/hide it, simply click on **SHOW** / **HIDE**.

- **Notifications**: You can set email addresses of people you want to be notified when the evaluation starts and/or when someone answers the form. *Advice*: Click on *modify* and then check *Add current registrants* if you want your event participants to be notified of the start of the evaluation.
• **Must have an account:** If an account is needed, visitors must first log in before accessing the form.

• **Anonymous:** When anonymous, logged submitters send their form anonymously. Otherwise their identity is known by the surveyor. *Note:* Users not logged in can always send their form anonymously. If you really need to know the identity of all your submitters, you have to click on *modify* then check *Must have an account.*

• **Special Actions:**
  
  - [Export evaluation](#): Export the evaluation with its questions to an XML file. Useful for backing up or transporting. *Note:* If the file is directly shown in Firefox/InternetExplorer6, save it with: *File > Save as...* To solve the same problem in InternetExplorer7: *Page > Save as...*

  - [Import evaluation](#): Import an evaluation from an XML file.

**Evaluation importation**

- **main setup configuration**  
  - keep current one  
  - overwrite with imported one (*loss of data*)

- **questions**  
  - keep only current ones  
  - keep only imported ones (*loss of data*)  
  - keep both

Concerning the main setup configuration (all the main information, e.g., title, announcement, etc.) you can choose to keep your current one or to overwrite it with an imported one. For the questions, you can keep only your current ones or only imported ones or have both (imported ones just after current ones). *Advice:* We suggest that you back up your current evaluation (with export feature) before importing in order to prevent loss of data. *Note:* In order to prevent some misunderstanding the status and the dates are not imported. Be aware that as questions and submissions are bound, you will also lose your current submissions if you get rid of your questions.

  - [Remove submissions](#): All collected answers will be erased.

  - [Remove questions](#): All questions will be erased. As the submissions are connected to them, they will also be removed!

  - [Reinit evaluation](#): Delete all evaluation informations, its questions and its submissions. You will have a brand new evaluation.
Edit

In this section you can add/edit/remove the questions in your form. On the left panel you have six different types of question you can add.

- **Textbox**: A standard field where your submitter can enter some text as answer to the provided question. Here is a little example of a question of type Textbox.

  ![Textbox Example](image1)

- **Textarea**: Like Textbox but with more capacity for text. Suitable for long answers like comments, feedbacks, etc.

  ![Textarea Example](image2)

- **Password**: Like Textbox but the answer is hidden. For example on the picture below, it is recommended that the answer is hidden if the submitter is in a public area. Otherwise anybody next to him would be able to read the password on the screen. Note that the evaluation module doesn’t use https, as all this information is not supposed to be confidential.

  ![Password Example](image3)

- **Select**: A drop down list which lets the submitter select one answer.

  ![Select Example](image4)

- **Radio**: A group of radio buttons which lets the submitter select one answer.

  ![Radio Example](image5)

- **Checkbox**: This type is suitable for multiple-choice questions. You can check more than one answer.

  ![Checkbox Example](image6)

When adding a Textbox/Textarea/Password you have the screen below.
• **Required:** If checked, an answer for this question is mandatory.

• **Question:** Enter your question.

• **Keyword:** A keyword is the summary of the question in one word. (e.g. “What is your name?” -> “name”)
   It’s useful when exporting the statistics into a CSV file. Instead of writing the full question, we just write the keyword so that it takes less place.

• **Description:** Enter a description (optional).

• **Help:** Enter a help message (optional).

• **Default answer:** The answer to the question will already be filled in with this given default answer (optional).

• **Position in form:** The position of the question within the form.

On the following picture you can see the result of the manipulation.

![Image of form](image)

When adding a Select/Radio/Checkbox you have the screen below. Note that some fields have already been described above, which is why they are not explained here.
Choice Items: Choice items are answers that can be selected. Note: Check the box next to a choice item, to set it to be a default answer.

On the following picture you can see the result of the manipulation.

After having first added some questions, here is an example of the questions overview (see picture below). You can change the position of a question within the form by clicking on . Press to edit a question and to remove it.
Preview

In Preview you can see what your evaluation really looks like in the display area. Feel free to play with this form, submitted information won’t be recorded.

Results

In this section we have the statistics. There are two panels called Options and Statistics.

In the first one you can select which submissions you want to see, remove some of them, and export all the results into a CSV file.

To import a CSV file into Microsoft Office Excel: Data > Import External Data > Import Data... > select your CSV file > Next > Uncheck Tab and check Comma > Next > Finish > OK.

In the second, you see the collected results of your evaluation shown as graphs or as answer lists depending on the question type.

Answer lists shown for Textbox/Textarea/Password:

1. what is your name?
   - anna
   - peter
   - someone

Graphs shown for Select/Radio/Checkbox:

6. which transport do you use?

<table>
<thead>
<tr>
<th>Transport</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>foot</td>
<td>67%</td>
</tr>
<tr>
<td>bus</td>
<td>33%</td>
</tr>
<tr>
<td>train</td>
<td>0%</td>
</tr>
</tbody>
</table>

8.3.2 Display Area

For a conference, you can access an evaluation via the left menu.

For a meeting/lecture, you can access it via the top menu.
9.1 Introduction

This section aims to describe the protection system used by Indico to grant or restrict access to users.

9.2 Basic Concepts

9.2.1 Inheritance Graphic

You can set up a protection policy for almost all the objects that you can create within Indico. This protection policy is based on an inheritance system, meaning that an object is going to inherit the protection from its father, e.g., a contribution can be public but becomes private if we set up its container (a meeting) as private.

The protection objects tree is as shown in the following picture:
As we can see, a **File** inherits the protection policy from **Material, Material** from **Contribution, Contribution** from **Session, Session** from **Event, Event** from **Sub-category and Sub-category** from **Category.** The next picture shows an example of this inheritance system. “Category A” is RESTRICTED and because of this, “Conference 1” becomes RESTRICTED too. As User 1 and User 2 are in the access list for “Category A” they can also access “Conference 1”. The rest of Indico users cannot access “Category A” and “Conference 1”.

### 9.2.2 Protection Types

For each object (category, conference, contribution, session, etc) in Indico, one can set up three kinds of protection: modification control list, access control setup, and domain control.

- The modification control list contains all the users or groups that can edit and modify an object. Therefore, people in this list will be the managers for the object and they can access all the pages related to it and the objects under it.
- Access control setup: by default, an object is inheriting but we can make it public or private and add restrictions as shown in the section *Access Control Policy.*
9.3 Access Control Policy

In Indico, an object can be a category, an event, a session, a contribution, material, files and links. You need to assign a level of protection to all of these events. There are three different kinds of events in Indico:

Public: Making an object public will make it accessible and visible to anyone. For example, suppose conference A belongs to category A. If the category A is private, but the conference A is public, then only allowed users will be able to access the category A, but everyone can access conference A.

Restricted: Making an object private will make it invisible to all users. You will then need to set the users which will have access to it. For example, suppose category B is public and conference B is private, and you allow users 1 and 2 to access the conference. Then everyone will have access to category B, but only users 1 and 2 will be able to see conference B.

In this graph, only restricted users have access to Category A, but everyone can access Conference A, as it is public.
In this graph, everyone can access Category B, but only restricted users can access Conference B, as it has been made private.

**Inheriting:** Making an object inheriting makes it inherit the access protection of its parent. Changing the protection of the parent will change the protection of the object. For example, suppose conference C belongs to category C. If you make category C private, then conference C will be private; if category C is public, then conference C will be public. Making a category which belongs to the category *Home* inheriting will make the category public by default.

Here is a graph that illustrates the inheriting example.
In this graph, we see how Category C transmits its access protection to Conference C (which is included in it), i.e. how Conference C inherits its access protection from its parent category, Category C.

By default, all objects in Indico are INHERITING.

### 9.4 Domain Control Policy

If an Indico object (category, event, session, contribution, material, file and link) is PUBLIC, we can restrict the access to users accessing Indico from some given IPs (these IPs could be like 127.1 which means that every IP starting like this will be valid).

If the Indico object is RESTRICTED, this checking will not be applied.

If it is INHERITING, it will have the same access protection as its parent. Its access protection status will therefore change whenever the parent’s access protection changes.